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Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services Lending
and Leasing. Since this section details the general options available in the User Interface,
some or all the parts of this section are applicable to you as per access provisions & licensing.

# Note:

The application can be best viewed in 1280 x 1024 screen resolution.

The document is organized into below topics:
* Audience

* Conventions Used

e Logging In

e Template and Navigation

e Common Operations

e Keyboard Compatibility

e Tool Tips

e Accessibility

1.1 Audience

This document is intended to all Prospective Users who would be working on the application.

1.2 Conventions Used

Table 1-1 Conventions

Term Refers to
The system/application Oracle Financial Services Lending and Leasing
Mnemonic The underlined character of the tab or button

1.3 Logging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system
administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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Chapter 1
Template and Navigation

When you invoke the application, the Sign In screen is displayed.

Figure 1-1 Login page

oracte: B o

Financial Services Lending and Leasing

e User ID — Specify a valid User ID.

» Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

1.4 Template and Navigation

This section provides a brief input on the template and navigation of the system.
Details are grouped into two categories to enable easy understanding. These include:

¢ Home Screen

e Screens

1.4.1 Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:
* Header

* Left Pane

* Right Pane/Work Area

ORACLE 1o
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Figure 1-2 Home screen

RACH ‘
Financial Services Lending and Leasing

A~ EIREE ©

DashBoard

4 DashBoard
DashBoard
Users Productivity
System Monitor
Producer Analysic
Process Files

> Origination
» Servicing
> Collections
> WFP

» Tools
 Setup

You can view the application version details and copyright information by clicking About link at
the right bottom corner of the screen.

Figure 1-3 About

About

Orade Financial Services Lending and Leasing 14.3.1.0.0
Build OFSLL_14.3.1.0.0_8253

Copyright @ 1998,2017, Oracie andior is affiiates. All ights reserved.

Oracke and Java are registered trademarks of Oracle and/or s affiiates. Other names may be trademarks of thei respective owners,

are al t and intellectual
property laws. permited in your or allowwed by law, you may not use, copy, reproduce, translate, broadcast, modify, license,
transmi, distribute, exhibt, perform, pubsh or display any part,in any form, or by any means. Reverse engineering, disassembly, or decompiation of this software,
unless required by law for nteroperabilty, i prohibited.

The information contained herein is subiect to change wihout nofice and i not warranted to be error-free. If you find any errors, please report them o us in writing.

Ifthis is software or related documentation that is defivered fo the U S. Government or anyone ficensing it on behalf of the U S. Government, the following notice is
appicable:

U.S, GOVERNIENT END USERS:  including any operating system, integrated software, any programs instaled . andior

delivered to LS. 't end users are *commercial compi Acquistion Regulation and agency-
‘specific supplemental reguations. As such, use, dupication, disciosure, modification, and adaptation of the programs, Including any operating system, ntegrated
‘Software, any programs installed on the hardware, anc No.
other rights.are granted to the U 5. Government

“This software or hardware is developed for generaluse n a variety of nformation management appiations. i & not developed or intended for use in any nherently

dangerous applcations, creste a risk of | iy applcations, then you shal
be responsible 1 take il appropriate faisate, backup, redundancy, and other measures {o ensure s safe use. Oracle Corporstion and s affiistes. disciaim any
Habitty for icati

may 0 or nformation on content, praducts and services from i partes. Oracie Corporation and s
affilates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and
5 afflites. wil ot be responsile for any loss, Costs, or damages ncurred due o Your access 1 or use of third-party conent, proGUEts, or Services.

| Qose

Header

In the Header, system displays the following:

* User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow, the
system displays the following options:

ORACLE"
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Figure 1-4 User ID - Options

M Welcome, VAVAIDYA 3

hange Fassword

[
m  UserInfo - =

— Change Password — Click to change the current password.

Figure 1-5 Change Password

ORACLE"
Financial Services Lending and Leasing Change Passtword

User Ifo Iy =

> DashBoard

Origination

[oracke Fnancio Sevices Lending and Leasing

Change Password

> Servicng
> Collections
> wrp

> Tools

> setup

Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

— User Info — Click to view the current user info.

Figure 1-6 User Info

"

| Oracle Financial Services Lending and Leasing *®
I
User Info
Organization DMC Time Zone (JSER TIME ZONE v
Division U501 Level
First Mame VARSHA User Time Zone UNDEFINED

Last Name  VAIDYA Company US/CENTRAL (CENTRAL STANDARD

Branch Time TIME)
Responsibility SUPERUSER s
R i il Server Time ASIA/CALCUTTA {INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT r Skin Family Skyros (Default) T

Debug Enabled Ind

ELE; Submit || 2% Close
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In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from the
drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the following
two types of system parameters:

Table 1-2 System Parameter

___________________________________________________________________________|
System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES_HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then
the debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database Server
Log Files.

You can click on 3= List Files button to view the list of logged files.
Figure 1-7 Database Server Log files

OoORACLE r me, PRAKRRA + (]
Financial Services Lending and Leasing

DashBoard »  System Monitor s [] Close
Batch Jobs  Jobs || Services = Database ServerLog Files | Parked Transactions | Users =
Database Server Log Files
view * Format~ [ Freeze  fi Detach il Wrap W) S=LstFiles  [E Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01_DB12C_2084400 b 5706 02/18/2016 06:14:11 AD ~
ALERT lob 395 02/22/2016 03:59:16 Ar_|
CSVPRC_EN_100_01 DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP 2
CSVPRC_EN_100_01_DB12C_3854338 lob 116750 02/22(2016 05:36:42 A
JSVPRC_EN_000_01_DB12C_20943562 lob 5706 02f18/2016 10:57:09 AP =
L
File Content
View v Format v Freeze  ff Detach o] Wrap o] ) Beginning @ End = oflines 50 [=] show File
Text

-

1

11: cmnsyp_cl_| .get_syp parameter value value: weblogic

1: emnsyp_cl_| .get_syp parameter value value: http://ofss2221142.in.oracle.com:

11: 45:FLL:1lv use BI::¥

¢ cmmsyp cl | .get_syp parameter value value: http://ofss2221142Z.in.oracle.com:

:11: cmnsyp cl | .get_syp parameter value value: /scratch/work area/DEV/QRI43REL/r 3
¢ cmnsyp cl 000 Ol.get syp parameter value parameter: J5V _BI USER
/_ REPORT ARCHIVE DIRECTCORY

/_REPCRTS SERVER TIMECQUT

:11: cmnsyp cl 000 0l.get_syp parameter value parameter:

1e parameter:

1: cmnsyp cl 000 0l.get_ syp paramete

Click on El Show File button to view the selected file contents in the File Content

%

section. You can also click
details.

Download File button to extract a copy of debug
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Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of this
user manual.

Click Submit to save the changes or Close to close the screen without changes.

* Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.

* NextGenUI - This is Next Generation User Interface option which is an enhanced interface
provided in OFSLL using the Oracle JavaScript Extension Toolkit (Oracle JET) frame work.
This is an additional interface supported from OFSLL to the existing system and both
intended to coexist in the system till further updates.

This option is enabled only if the corresponding system parameter is enabled in the base
system as configured by your system administrator. For more information, refer to
Appendix - Oracle JET Interface section in Servicing guide.

*  Sign Out — Click the link to sign off from the application. You can also click on

icon to sign off from the application.
Left Window

In the left pane, system lists and provides drop-down links for various modules available in the
product. Click ~ to expand the Module Master Tabs and “ to collapse them.

1-6
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Figure 1-8 Left Pane

» DashBoard
> Origination
Servicing
Eervidng =
Customer Service
Securitization
Transaction Autharization

Post Date Checks
Escrow Transactions

m

Account Documents 4
Collateral Management
Reports

Producers

Vendors
Batch Transactions
Interfaces
AP Transactions

GL Transactions 57

» Collections
= \WFP

> Tools

» Setup

To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press Enter. The screen is
displayed in the main window/work area.
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Figure 1-9 Left Pane Search

ORACLE w BR « g sgnout ©
Financial Services Lending and Leasing
Al @0 | Access » 36 Close
Appiication Retrieval (Originatior) Data | Screen | Reports || Correspondence | Transaction
Application Documents(Origination)
Asset Types(Setup Products) Access Grid opadd | et || [E vew | o Audt
Aot DeametsGeanl View v Format~ [ Freeze i Detach wrap W
U
=3l o i Division Company Branch Mlowed
AP Transactions(Servidng Interfaces) DMC UsoL ALL AL ¥
Application Entry (Origination) oMe NLOZ AL AL Y
Audit Tables(Setup System) oMe a0z ALL AL v
Advances(Servicing Batch Transactions) oMC P04 AL AL ¥

> Origination
> Servicing
> Collections
> WEP

> Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through the
module from which the screen is accessed which is indicated in angular brackets. For example
typing VEN displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

Figure 1-10 Right Pane

opacie )

Financial Services Lending and Leasing

Close
> DashBoard Sales Lead x £l
Origination Lead Entry | Follov-Up | Maintenance

Origination
Sales Lead Applicant Information P add | Aedt | Elview |  audt
Simple Application Entry
View v Format v Freeze Detach &l Wrap
Application Entry 2 4 o @
Unsiasiaitis Lead Lead Dt Company Branch First Name. Last liame Birth Dt Channel Source Type Country Address = city
ey L-00002008 115/2015 N2 g ROSEMARY BLACK 1081367 CONSULTATION  WEB ENTRY HOME UNITEDSTATES 813w Juncos
L T L-00001002 1022015 uso uskQ TEST TESTLASTRANE  01/03/1990 ESTATE AGENT UNITEDSTATES 1000 PLYMOU
s sl L-00003002 12/17/2015 usot uskg ] JanEs 01/01/1997 UNITEDSTATES 1000 BOTHEL!
s L-00002002 12/12/2015 uso1 UsHQ PHANINDRA CHODA 10/10/1982 CONSULTATION UNITED STATES 89898 IRVINE
L-00002004 12f12/2015 uso1 UsHQ BOREN ROBERT 1203/1970 UNITED STATES Juncos
L-00005002 02/03/2015 uso uskQ o] 305H1 07125/1988 CONSULTATION UNITEDSTATES  ADDL coaro
Loo003004 1211912015 uso1 uskQ ANDRES MARTINEZ 08/06/1989 ConsuLTATION UNITEDSTATES  LEAD ENTRY Loza
Lo000s002 1212312015 usor uskQ san sam 11/13/2991 oTHERS VIEB ENTRY HOlE UNTEDSTATES 123 PONCE
‘endor
»
Telecoms = Comments = Documents —Requests
‘
Telecom Information A add || A Edit | 5 view || o Audit
Vieww Fomate B | [[Freeze BiDetah  Jwrs @)
Telecom Type Phone Current.
(CAR/MOBILE PHONE (o0sys32:3423 ¥

> Servicing
> Collections
> WFP

> Tools

> Setup

You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

ORACLE 18
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Figure 1-11 15 Screens

ORACLE" # Welcome, VAVAIDYA + o
Financial Services Lending and Leasing
P 0] <y [Transaction Authorization x | Post Date Checks x | Escrow Transactions » || Account Documents ¢ | Collateral Management x | Reports x| Producers x | Advances x| Paymentsx | Feasx | AP Transactions x || GLTransactions x ~ 0
> Origination Authorization | Authorization History Review Requests (Pending: 0}
Servicing
Transactions Z Edt | Bl view | o audt
Vieww Formatv [ Freeze i Detach wrap @) @ Checker O Maker C) Both ® 1Day (0 2Days () 5Days O AllDays  viewFailed (] §8%Post [El void
Account = Txn Dt Transaction Status Maker Initiated Dt Checker Authorized Dt Comments
20150200010030:KARTHIKRAGHAVEIL.. 02/10/2015 ACCOUNT CLOSE ERROR ViEHATIA 02/10/2016 UNGEFINED
20121000010585:8ROVN PAUL/ PAULA 02/09/2015 CHARGED OFF ERROR VEROUTHU 02/09/2016 UNDEFINED
20160100014008:B00 SUMAN 02/09/2016 CHARGED OFF ERROR VEROUTHU 02/092016 UNDEFINED
Collateral Management
Repwts Parameters
ik g View v Fomat~ [ Freeze f7f Detach wop | @@
Parameter Value Required
TXN DATE 02/09/2016 L2

4 Transaction Processing Details

Vieww Format~ B Freeze L Detach rap 5]

> Collections
> WEP
> Tools
> Setup

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background. Also,
operation on any of the screen will not affect the data in other screens.

Few screens in WFP are identical and are linked. Hence, when multi tab option is not enabled,
you can open only one screen at a time from the group. A sample of the grouping structure is
given below, based on stages of the screens:

WFP

¢ Producers
e Credit Lines
e Units

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on Application and Customer Service screens. You can

click {and b to toggle the view of Right Splitter/Action Window.
Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

1-9
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Figure 1-12 Right Split Window Application

ORACLE i #, Welcome, VAVAIDYA v o
Financial Services Lending and Leasing
Close
 Dashoard originstion x ®
Search/Task  Fundings 0000000378  Review Requests (Pending: 0) B
Quick Search
Application: 0000000378 TIFFANY RUSSEL / GRACE (Bl view || 2 audit et
Vieww Fomatw [ Freese 5 Detach wiap | @) OverideoK ¥ WamingOK v e
Origination Stage b Duplicate Itiadcy
Dt App = Sub Unit Status Code Producer Name r[‘: Existing Customer Aapplication Contact * Eﬁ T é[\ear
lication Retrieval 01/01/2012 0000000378 UNDEFINED /APPROVED - FUNDED FUNDED (GA-00004 : ADVANCE LEA. N N
cenario Anlysis » Summary
Application Documents s e
image Mainterance Advance 15,000.00 15,000.00
Reports s
Producers summary || Applicant || Request | Decision | Contract | Collateral || Comments | Tracking | Document || Verification || Correspondence | Tools ’:““ i:“”“ ;E“““
em
Vendors
> Applicant Grade DGRADE  Score 0
v o1seo L2 15000
Stated PTI954 Stated After DTS8.92
4 > Ratios Book 10,000 ileage 0
AssetDesc 2012 CHEVROLET MONTE CARLO
= 0
> Bureau
Quene FUNDED APPLICATIONS QUEUE
B Cheniaet Change Status
Status APPROVED - FUNDED
Collateral Change Status
Collateiml Add Comment
hsset Type SubType Primary  Year vake Wodel Vileage New Wholesale Value =
> Servicing VEHICLE car v 12 CHEVROLET MONTE CARLO N 10,000.00 Blert
> Collections “Trpe
s * Sub
AWER Trade-In Type
> Tools * Comment
> Setup Trade-In - -

* Use Quick Search to search for an application based on application number, last 4 digits
of SSN (SSN of the primary applicant) or identification number. If multiple applications or
accounts are found during Identification # search, the system displays an error message
as “Multiple Matches found for the Identification #, Please use normal Search”.

*  Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate and
Term.

* Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the Change Status will be read-only.

* Use Add Comment section to post an alert or comment during Underwriting and Funding

stages.
For detailed information on the above options, refer to respective sections in the document.

Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:
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Customer Service

Search | Customer Service: 2017010010097 R Request (Pendng:0) | Queve Assgrment

Summary | Collecs

Account Details

Dues
o3/10/2017
50,03

o7/10/217

os/10/2017
1,550.12

o/10/2017 os/10/2017

NSFUR) 0 Colector DBMOCOLL

Actve Dt 08/38/2017
Last Actvity Dt 03/05/2017

enkuptcy | RepofForecosure | Defidency

Account(s): 20170100010097: Bven | L auit
Vew~ Fomatv B} [|Fres= pHiDetach » @ & ©CcurentOshon Al O GoupFolowp
Cangany At = roduct Oays pastoue Curency fayOffAmt  Amountue Staus Odestoue0t  DLQResn
sot 017010010057 LOANVEHLE (%) 1538155 200,21 (ST o=/ 017 15T PAENTDEL

Conditions,

Conditions

DELINQUENT

Other Information

Collateral Information

prmory  Desrpton Mottt Nex AstCass AsstTe  SbTye b
v 206 CHEROLETHONIECARO DR 284GPA5GIRIT252. 2005 NeW wice  om
Customer Information BPostcomment | [ @ Cear
Gustones
% e st son T Gonder 'Add Call Actiiy
oo WAHAN ORAGLE iy s -0 oyspisss uose ackon =
=
RSIGGHALL COM 2
s =
osne stop Care
Address Information 5]
mmmmmmm o
T T o
rove Y Y snemokasw s Y
=]

Employment Information

s5/Up Sel Actvites | | Externa Interfoces

[ swomit | [ @ Cex

Queue/ Condtion ~|
AR
[ et et
CondtonSutot om0t
wmmn wmm
oarmmsy

[ St At

08/18/2017 Add Comment
slre

“Type ReaR 2]

*SiTye =

Brostcalacity | [ goes

e Use Quick Search to search for an account based on account number, or customer Id, or
last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during Identification # search, the system displays an
error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking Next Account button opens the subsequent account listed in search and clicking
Filtered Account opens the subsequent account fetched during a queue search and listed

in Queue Assignment section.

* Use Add Comment section to post an alert or comment based on Type and Sub Type.

* Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is similar
to the option available in Call Activities sub tab under Customer Service tab.

For detailed information on the above options, refer to respective sections in the document.

The height of Header and width of the Left and Right Panes do not change, with resizing of

application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click = to toggle upper pane and {to toggle left pane.
To un-toggle click == and 3 respectively.

This section consists of the following topic:

 Time Zone Preference
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1.4.1.1 Time Zone Preference

Figure 1-14 User Info

| Oracle Financial Services Lending and Leasing *®

User Info
Organization DMC Time Zone USER TIME ZONE r
Division US01 Level
First Mame VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD
e Branch Time TIME)
Responsibility SUPERUSER p S
L Bosz Mste I 2014 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Legin Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT X Skin Family Skyros (Default) v

Debug Enabled Ind

B3 submit || 3% Close

You can select any of the following three time zones from the User Info screen:
e Application Server Time Zone
e Company Branch Time Zone

e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under Division Definition.

e Inthe Display Formats tab, select Time Zone and click Edit.
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* Inthe Format field, select the required time zone from the adjoining options list and click
Save.

If Company Branch Time Zone is selected as the time zone in User Info screen, then on
save, all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.

To modify the User Time Zone:
e Navigate to Setup > Administration > User > Users.
«  Select the required User record listed in User Definition section and click Edit.

* Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If User Time Zone is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

1.4.2 Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped. As
similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on Customer
Service tab, the corresponding tabs are displayed.

Figure 1-15 Customer Service_Example

Customer Service x [Fcle
search  Customer Service: 0120200010231 PeweuRequest(venqu:n)l
Account(s): 20120200010231: YUTAKA OZAKA / AKANE Elview || o avdit
Vieww Format~ [Ep Freeze i Detach Wrap B & © cument O Showall O Group Fallow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
usot UsRL UNDEFINED 2012020010231 LEASE VEHICLE 0 UsD 0.00 0.00 ACTIVE 02/10/2015
[ summary ICustomer Servicd _Account Details _Customer Details _Transaction History Pt Modes | Bankuptcy | RepofForedosure Deficiency  Collateral Bureau _Cross/lp Sell Actvties |
‘ Call Activities ~ Maintenance =~ Comments Promises Checklists Tracking Attributes ~ References  Correspondence  Letters — Document Tracking
Call Activities . Fadd || et || Eview || o audit
View= Format~ [y Freeze i Detach wrap M

Action Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Followup Dt Time Zone Adj Followup Dt Cor
AT PH ANSWERING MACHINE N 12/30/2015 1,000.00 NONE N 12/30/2015 12292015 12:30:00 PM
AT PH ANSWERING MACHINE N 12/30/2015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM

»

You can click » to view the hidden tabs, if any.

1.5 Common Operations

Some of the operations are common to most of the screens.

These are grouped into following categories, based on their features.
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e Basic Operations

e Basic Actions

e Personalization Options

*  De-supported Special characters
e Skip Zip Code Validation

*  Export data to Excel

1.5.1 Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
e Edit
*  View
*  Audit

ok add | A Edit | 5] view || < Audit

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Table 1-3 Basic Operation

]
Basic Operation Description

Add Click to add a new record. When you click Add, the
system displays a new record enabling you to
specify the required data. It is mandatory to specify
details for the fields marked with ** symbol.

Edit Click to edit an existing record. Select the record
you want to edit and click Edit. The system
displays an existing record in editable mode. Edit
the required details.

View Click to view an existing record. Select the record
you want to view and click View. The system
displays the record details in display mode.

Audit Click to view audit info. If an audit is set for a field,
then the system tracks the changes for that field.
Select the record for which you want to view the
audit info and click Audit. The system displays the
details tracked for that field.

Close Click to close a screen or a record. When you try to
close an unsaved, modified record, then the system
alerts you with an error message. You can click Yes
to continue and No to save the record.

1.5.2 Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.
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All or few of these actions are enabled when you select any of the Basic Operations.

El Save and Add E Save and Stay El Save and Return <3 Return

The table below gives a snapshot of them:

Table 1-4 Basic Actions

_________________________________________________________________________________|
Basic Actions Description

Save And Add Click to save and add a new record. This button is
displayed when you click Add button.

Save and Stay Click to save and remain in the same page. This
button is displayed when you click Add/Edit button.

Save And Return Click to save and return to main screen. This button
is displayed when you click Add or Edit buttons.

Return Click to return to main screen without
modifications. This button is displayed when you
click Add, Edit or View buttons.

The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Table 1-5 Navigations

Basic Actions Description

Click to navigate to the first record.

Click to navigate to the previous record.

Click to navigate to the next record.

b |

M |

Click to navigate the last record.

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Table 1-6 Buttons for Specific actions

Basic Actions Description

Show File - Click to view the details of selected file.

E
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Table 1-6 (Cont.) Buttons for Specific actions

Basic Actions

Description

List Files - Click to generate and view the list of
files maintained in the system.

Download File - Click to download the details of

E‘ selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the

settings for that User ID until next personalization.

Figure 1-16 Personalization Operations

|\n'iewY Format » | P Freeze &= Detach U Wrap EE!'

The table below gives a snapshot of them:

Table 1-7 Personalization Options

Options

Description

View

Click to personalize your view. The drop-down list provides the following
options of customization:
e Customize columns you wish to view

e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options adjoining
View.

M Format ~ | Ep Freeze £ Detach

Columns * Show Al
| R + Product |
Detach + Description |
Sort v« StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

ORACLE
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Table 1-7 (Cont.) Personalization Options

Options

Description

Format

Click to resize columns or wrap a data in the table cells.

Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column =

Column DESCRIPTION
width [ 100 & [Pixels  [=]

| OK | Cancel

Specify the Width and unit for the selected column. Click OK to apply
changes and Cancel to revert.

Query by Example

Click to query for the data by an example. When this option is selected,
the system displays an empty row above column heads. You can specify
all or any of the details of the record you wish to query.

View » Format #
¢ |

Freeze Eff Detach ol Wrap [ee)

| @) EY

Freeze

Select the column at which you need to freeze the table and click
Freeze. Function is similar to the freeze option in MS excel.

Detach

Click to detach the setup table from the screen. An example of the
detached table is provided below.

Wrap

Select the column in which the data needs to be wrapped and click
Wrap.

Loan Line Lease

Product Definition shadd | et | [Even | o st
vew - [femetsl B | @I e [ | @ e Procuct Create Copy
| I redit Bure
|Product Jendot [prect [reutie Repayment |ereed [ctoterairype  [cotetera sorpe [Sedtpees |
M LoAN+HE 12/31/4000 Y bé L4 HOME COLLATERAL REAL PROPERTY HOM INSTALLMENT I
LoANsE 12/31/%000 N N v HOUSEHOLD GOCDS PERSQNAL PROPERT INSTALLMENT
|
|
LOANAN 12/31/4000 4 \ ¥ UNSECURED COLLATINSECURED peTALET E
LOAN-VE 12/31/4000 N ¥ ¥ VEHICLE COLLATERA PERSONAL PROPERT INSTALLENT -~
voP 1 12/31/000 v N ¥ VEHICLE COLLATERA PERSONAL PROPERT INSTALLVENT
MURABAHA 03132013 v N ¥ HOME COLLATERAL REAL PROPERTY HOMINSTALLMENT
nDS1 12/31/%000 v N 3 UNSECURED COLLATIUNSECURED INSTALLMENT
PO 12/31/%000 Y N 12

HOME COLLATERAL REAL PROPERTY HOMMORTGAGE -
i ,

Click to refresh the data in the table.

ORACLE
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Table 1-7 (Cont.) Personalization Options

________________________________________________________________________________|
Options Description

View Last For usability and performance, some of the data intensive screens have
View Last option to sort the volume of data being displayed on screen
based on elapsed days.

view Last ©) 1Day @) 1Week© 1Month@ By Date startDt 07/01/2017 [ EndDt 092002017 b &B

You can select the View Last option as 1 Day / 1 Week / 1 Month / By
Date. When By Date is selected you can specify a date range (within 3
months) in Start Dt and End Dt fields using the adjoining calendar and
clicking Search.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print
the contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new tab
is opened where the print content is displayed.

Detach

Figure 1-17 Detached Table

ORACLE" & Welcome, vavarova ~ EISEGRIGN <
Financial Services Lending and Leasing
& Close
e 13 " customer service =
> Origination | : 1 :0) =
Account(s): 2012020001023 1: YUTAKA OZAKA / AKANE [Elvew || 2 audit
View+ Format~ [ Freeze Pfivetach  Jwep @ & @ Cument O ShowAll O Group Follow-up
Company Branch Sub Unit Account = Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
usot USRL UNDEFINED. 2012020010231 LEASEVEHICLE 0 usD 000 0.00 ACTIVE 02/10/2015
Summary | Customer Service | Account Details | Customer Details | Transaction History Pt Modes || Bankruptcy | RepofForeclosure || Deficiency | Collateral || Bureau || Grossfup Sell Actties
Call Activities | Maintenance || Comments || Promises || Checists | Tracking Attributes || References || Correspondence | Letters || Document Tracking
Reports
Producers E ?
Visidors Transaction Batch Information padd | S Edt || [Eview || o audit
e View Formats | B Freeze B Detach war | @ S post [ vaid
Date Honets Transaction Status Batch
Payments 02/10/2016 ADD CUSTOMER ADDRESS PHONE POSTED N
Fees g 75016 v TERMINATE ERROR [
Interfaces 01/06/2016 v TERMINATE vo u «
P Trane 010EPY6 ECENSION van L
Detached Table
View~ Format~ B} Freeze [0 Detadh rap W@ #3post [} vaid
Date Honetary Transaction Status Batch
02/10/2046 N 'ADD CUSTOMER ADDRESS PHONE POSTED
01/07/2016 Y TERIINATE ERROR i
01/06/201 v TERMINATE vom [
01/06/2016 Y EXTENSION vom i
127242015 v PAYOFF QUOTE LEASE POSTED ¥
View~ Format~ [ Freeze f Detach wep | @
> Collections rocessing Details
> wEp Direct Record Update, Transaction Posting Successful =+
> Tools
> Setup

Click Add, Edit or View button to open a new screen in expanded mode with details.
Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you provide
the alphabet, system limits the selection to the values starting with the specified alphabet.
These lists are grouped into two types:
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»  Drop-down list — Provides the selection option. You can either select a record from the list

or enter first alphabet of the required value.

e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

Figure 1-18 Combo drop-down

ORACLE & welcome,vavaons - =)
Financial Services Lending and Leasing
Close.
T Customer service EE
> Origination 2rerEn| © :0)
Servicing
= Account(s): 20151200010012: MADHU BOBBURI Eview [ 2 auit
Views Fomatv [ | [[[Freere EiDetach  clwap | @ & © Curent O Showl O Group Follov-up
Company Branch Sub Unit Account & Days Past Due Currency Pay Off Amt Amount Due Status. Oldest Due Dt
usor useg 2015120001012 LOANVEHICLE (FR) s031851 EEEEN 2 Crive:0EL0:von pero . [SIIERTY
Account Documents QUSR] | Customer Set Acotprtats) [loms *
Collateral Management
gement Call Activities | Maintenance | Comments P
Reports o
Transaction Batch Information e add ||/ dt yi & Audit
View~ Fomatv [ Freeze ot Detach Wrap (5] #rost [ vaid it
Date Monetary Transaction AcComTC r 'y
02/10/2016 ¥ ACCOUNT e Search: Transact
‘ 01252015 [ ACCOUNT SUB UNIT TRANSFER P rilies
01/22/2016 N ACH MATNTENANCE > Search Basic
o1/07/2016 N ACH ONE TINE PHONE PAY
12/15/2015 v ADIUSTMEIT TO ADVANCE | PRINCIPAL - ADD

Transaction Batch Information

Parameters

> Collections e | 3
P

> WEp o data to dicplay

> Tools

kiseum Result

Date
* Monetary

02/10/2016
C)

ceze ffi Detach wep @

Reset | | AddFields ~ || Reorder

an or equal to o || cancel

Click the arrow button available before Search to toggle the search options.

Table 1-8 Search options

Buttons/Menu Do this

Basic Click Basic for normal search.

Advanced Click Advanced for advanced search. In this mode,
you can select the search option from drop-down
list adjoining the search criteria. Selected record
will be highlighted (Hover to select).

Match Select All to display results exactly matching the
specified characters. Select Any to display results
matching any of the specified characters.

Search Click to search for values based on the specified
search criteria. The search results are displayed
below with the details in respective columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the Match field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual

ones.

ORACLE
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Figure 1-19 Search Memory

| * Channel | WEB ENTRY [=] * Producer Name |
NY-02 : PR : HOLTSVILLE 43125313712
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR e 1
TIF-OUOO L T TEST-00 T AOTONTAS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

1.5.4 De-supported Special characters

OFSLL does not support the following special characters while accepting data through Ul,
web service and file upload process.

<>{}N\"[I

Hence, ensure that the same is not used while processing any input data in the system.

1.5.5 Skip Zip Code Validation

ORACLE

While accepting data for interdependent fields through User Interface, OFSLL validates and
auto-populates the values for subsequent fields based on previous selection.

Accordingly, when a specific Country is selected from drop-down list which is populated based
on COUNTRY_CD (COUNTRY CODE) lookup code, OFSLL validates and populates the list of
corresponding zip codes maintained in Zip Code setup.

However, in case the zip code validation is to be skipped for a specific Country, then define the
Sub Code as NO_ZIP_VAL against the COUNTRY_CD in lookups screen as indicated below:

Figure 1-20 Skip Zip Code Validation

Lookups x (3] Close
Lookup Type H Add | A Edit || [F] view || & Audit
View v Format » E Freeze ;f Detach Wrap E@

Yes

& “COUNTRY%
No

System Defined

Lookup Type Description Yes/No Enabled
COUNTRY_CD COUNTRY CODE (SORT BASED ON CODE) Yes () No Y
»
Lookup Code P Add | FEdit | ] view || & Audit
View v Format « @ Freeze ;ﬂ Detach Wrap GE
é Yes
%NOY
%NO% No
Lookup Code Description Sort Sub Code SEEmEEEY Enabled
Yes/No
UK UNITED KINGDOM 1|NO_ZIP_VAL Yes (L) No Y|
SG SINGAPORE 1|NO_ZIP_VAL Yes () No Y~
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On Selecting that particular Country from drop-down in any of the Ul screen, only the default
value ‘0000000000’ is available for Zip field drop-down list. On selecting the same, the City and
State fields are set as UNDEFINED.

Figure 1-21 Skip Zip Code Validation

Producer Details
B Save and Stay B Save and Retun CJRetum

Producer # CO-00004 Address Line 12145 HWY 50 WEST Max Float 99,099
Old Producer # CO-00004 Address Line 2 Remaining Float 99999
* v
Name DALE SPRADLEY MITSUBISHI Country UNITED KINGDOM 5 Enabled
Company  ARGOL v
pEy, Zip 0000000000 hd <Subvention Participation
Branch ARO1 v ) 0000000000 UNDEFINED UNDEFINED
Zip Extn
Start Dt 05/27/1004 [y " Search..
City [ONDErTNED =i
End Dt 12/31/4000 | )
State UNDEFINED v Collection Type | STATEMENT v
Contact  JACK * Permission hlgi Collection Frequency MONTHLY 34
Group | NOT DEFINED X . Perm\ssioncic Refund Disbursement NONE v
Method
Grade hd Text o i =
egion
Type DEALER ¥ Phone 1 (719)-543-6710 N
Territory | ALL ¥
Status | ACTIVE v Bn10 i,
Sales Agent i * Permission to License Details
Underwriter DEMO UNDERWRITER v call
* Permission g
Funder v S ot Valid From |01/01/1800 [2:)
Collector ' DEMO COLLECTOR v Phone 2 Valid To 12/31/4000 B

# Note:

Skipping zip code validation has significant impact in the system since the change
impacts all the Ul screens - Setup screens, Origination, Servicing and Collection
module screens, Interface, Customer Credit Limit, Collateral Management, and so
on. Hence it is recommended to be done with careful consideration and OFSLL is not
responsible for any impact/ mismatch resulting out of this change.

1.5.6 Export data to Excel

While working on any of the screens in User Interface, OFSLL provides a flexibility to Export
the data that is displayed on screen to an Excel file. This helps to download and view the data
offline especially with data intensive screens.

Clicking Export to Excel option provides option to save the data to . x1s file.

Figure 1-22 Export to Excel

Summary = Collections ~Customer Service = Account Details ~ Customer Details =~ Customer Preferences =~ Transaction History = Pmt Modes = Bankruptcy = RepofForeclosure | Deficien > ¥

Call Activities Comments Promises = Checklists =~ Tracking Attributes ~ Field Investigation = References = Correspondence =~ Letters = Document Tracking = Scen: > ¥

Transaction Batch Information Padd | AEdt | [ view | o Audit
View v Format v E”"f' Freeze ;f Detach Wrap @ o8 Post % Vaid
Date Monetary Transaction Status Batch
10/29/2020 ¥ PAID OFF POSTED N
10/23/2020 N ADD CUSTOMER ADDRESS PHONE POSTED N

Parameters
View v Formatv  [Ep Freeze 4l Detach Wrap o)
Parameter Value Required
TXN DATE 02/11/2020 Y
WRITE OFF INDICATOR YES Y
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However, Export to Excel option is currently available only to following screens and is also
access controlled depending on configuration defined in setup.

*  Queues/Search Results - Origination, Servicing, and Collections
e Account Information

e Balances

e Call Activities

* Maintenance

*  Promises

e Due Date History

e Collateral

e Tracking Attributes

*  Condition Details / Condition / Queue History

In additional, OFSLL displays the total count of records fetched from database. The count is
displayed in the right bottom corner of records table. However, note that this is not the total
count of all the records in the database but only the records which are fetched based on
specific selection. For example, if there are 50,000 records in database and Ul is fetching
1,000 records, then the count is displayed as 1,000.

1.6 Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as Hot Keys. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
Accessibility screen, press ‘Shift + Alt +y'.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

3. Space bar to check or uncheck Check Box.

4. Arrow Keys to hover within the drop-down list.

* Keyboard Compatibility

1.6.1 Keyboard Compatibility

ORACLE

The application is made compatible with keyboard only-operations. However, there is a change
in key combination based on the browser on which the application is running.

Table 1-9 Keyboard Compatibility
]

Browser Operating System Key Combination Action

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + Click
mnemonic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic  Click
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Table 1-9 (Cont.) Keyboard Compatibility

Browser Operating System Key Combination Action
Mozilla Firefox Mac OS X Control + mnemonic Click
Mozilla Firefox Windows Alt + Shift + mnemonic  Click
Microsoft Internet Windows Alt + mnemonic Set focus
Explorer 7
Microsoft Internet Windows Alt + mnemonic Click or set focus
Explorer 8
Apple Safari Windows Alt + mnemonic Click
Apple Safari Mac OS X Control + Option + Click
mnemonic

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom
level.

Table 1-10 Keyboard shortcuts

Shortcut Action

Ctrl++ To increase zoom level.

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.

1.7 Tool Tips

The system is facilitated with tool tip option.

When the cursor is moved on any of the user interface field in the screen, a popup is
displayed. It consists of a tip with the action that has to be performed.

1.8 Accessibility

This section consists of the following:

* Understanding Accessibility
* Application Accessibility Preferences

*  Documentation Accessibility Preferences

1.8.1 Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.
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1.8.2 Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility to
make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define
special accessibility preference in the application:

e The application user interface contents are readily accessible for all types of users without
the need to select special accessibility modes.

e The components within the user interface are optimized for use with a screen reader by
default.

e The contents are zoomable by default, eliminating the need for an application large fonts
mode.

e The user interface components auto-detect if operating system (OS) is set to high contrast
mode and automatically render content that is compatible with OS high contrast,
eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built on
Oracle Application Development Framework (ADF) and the default accessibility feature
supported by ADF are made available. For additional information, refer to ADF documentation
on accessibility preferences.

1.8.3 Documentation Accessibility Preferences

ORACLE

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics

» Usage of standard fonts and avoiding shadow or reversed text

* Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
* Usage of styles and formatting elements

* Documentation in simple language to ensure easy understanding

* Including accurate and effective navigational features, such as cross-reference, tables of
content and bookmarks as appropriate.
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The Dashboard consists of the following sections:

* Introduction

» Dashboards

e User Productivity
e System Monitor

e Producer Analysis

*  Process Files

2.1 Introduction

This document is designed to help acquaint you with the features of Dashboard, on the landing
screen of Oracle Financial Services Lending and Leasing. Information from multiple products is
integrated and displayed as Dashboard on home screen of the application.

This manual explains the functionality of Dashboard facility and various Dashboards present in
the system. Since this section details the general dashboard options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions &
licensing. Besides providing these details, the manual also provides a brief description of other
features associated with Dashboard link. The Dashboard main Menu further provides links to
the following screens:

» Dashboard
e Users Productivity
e System Monitor

e Producer Analysis

2.2 Dashboards

ORACLE

Dashboards are the tiny windows displayed on landing screen of the Application. Dashboard
renders quick and crisp information of specific transactions or tasks mapped to the User Role,
who logs on to the system.

The system facilitates integration of Information from different levels and displays it as
Dashboard on home screen, also called the landing screen of the application.

Navigating to Dashboards

Click Dashboard > Dashboard > Dashboard.
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Figure 2-1 Dashboard
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DashBoard »

Origination
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System Monitor

My User Queues

Number of Accounts

No data to display.

Queus Description Count

Setup

Product Expiring in Next One Month

Producers Expiring in Next One Month
Producer End Date
No data to display.

Admin

Critical Batch Job Status

Producer Analysis Description Count Product End Date Batch Job Status
Process Files No data to display. No data to display. MNa data to display.
My Pending Review Requests By Applications
App # Priority
No data to display.
My Pending Review Requests By Priority
Pricrity Count
No data to display.
i Servicing Producer Vendor
Number of Queues Hard Assigned A Producers Count By Status Vendors Count By Status
Queus Description Count Status Count Status Caunt
N data to display. ACTIVE 82 ACTIVE 35

Vendors Expiring in Next One Month
Company Name End Date

No data to display.

3 Close

My Pending Review Requests By Accounts
Acc# Priority
No data to display.

> Origination My Pending Review Requests By Priority

> Servicing Priority Count
> Collections

> WFP

> Tools

> Setup

Features

Following are the features of Dashboard:

*  The system organizes Dashboards to provide comprehensive and consolidate snapshot in
tiny windows, to access information easily. Thus, helping to; analyze, monitor and make
better decisions which in turn help save time and cost.

e The screen is designed to display six Dashboards, distributed in two rows with three
Dashboards per row, without scroll bars.

*  The height and width of all Dashboards are fixed; however, you can expand or collapse the
Dashboards. Click the arrow heads at the top left corner of the Dashboard windows to
expand or collapse the dashboard windows.

« Each section in Dashboard is hyperlinked to home screen of the respective section. The
main screen will present descriptive information of details shown in Dashboard only.

e Each window in the dashboard is provided with a L8 Refresh button and clicking on the
same would fetch the latest status of the dashboard being viewed.

2.3 User Productivity

Oracle Financial Services Lending and Leasing User Productivity screen is a supervisor
feature that allows you to monitor the daily performances of users completing origination and
servicing tasks.

These tasks are categorized as underwriting funding tasks (loan origination) and customer
service/collection tasks. The system updates these details on daily basis.
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Using the User Productivity screen, you can review the following daily tallies:

Number of accounts worked and call activities, by user

Number of accounts worked and call activities, by queue

Number of applications entered, by user

Number of underwriting decisions (approved, rejected, conditioned, or withdrawn), by user
Number of funding decisions (verified or funded), by user

Number of applications entered, by queue

This chapter explains how to use the User Productivity screen to view this information.

Navigating to User Productivity Screen

1.

On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > User Productivity.

The system displays the User Productivity screen. You can view the tasks related to:
e Underwriting/Funding

e Customer Service/Collection

2.4 System Monitor

The System Monitor screen is the one stop place to check all the activities in and around the
system. It maintains the progress of;

ORACLE

Batch Jobs

Jobs

Services

Database Server Log Files
Parked Transactions

Users

Navigating to System Monitor

On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor.

This section consists of the following topics:

Monitoring Batch Jobs
Monitoring Jobs
Monitoring Services
Database Server Log Files
Parked Transactions
Monitoring Users
Monitoring JMS Queues

Monitoring Events
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2.4.1 Monitoring Batch Jobs

The system tracks the success of each batch process on the Batch Job. If either a set of batch
jobs or specific batch job should fail, you can resubmit it on this screen and review the results
in Request Details section.

The Monitor Batch Jobs screen is only a display screen that contains the following sections:
* Batch Job Sets

* Batch Jobs

* Batch Jobs Threads

e Request Details

* Request Results

To Monitor Batch Job

1. Click Dashboard > Dashboard > System Monitor > Batch Jobs.

2. Inthe Batch Job Sets section, you can view the following information.

Figure 2-2 System Monitor - Batch Jobs

ORACLE" " ; & Welcome, PRAKRRAO ~ o
Financial Services Lending and Leasing
System Monitor x [3 Qose
Batch Jobs  Jobs Senvices Database Server Log Files  Parked Transactions  Users
Dashgoard
Users Producivity
System Monitor Batch Job Sets
Producer Analysis View v Formatw [ Fresze i Detach Wrap ) B Re-submit Job Set
Process files et Code Job Set Description  Status Fraquency Frequency Value  Start Tima Enabled Critical Last Run Dt Next Run Di
SET-AAL ACCOUNT CREATL.. READY DAILY DAILY 10:00 AM N N 08/08/2003 08/09/2003 A
SET-ACR ACCRUALS AND D... READY DAILY DAILY 10:30 PM N Y 08/07/2003 08/08/2003 W
<
Batch Jobs
View v Formatv b Freeze i Detach Wirap & (B Re-submit 30b
Seq Job Type Job Code Status Job Description Threads Commit Count Errors Allowed Weskend Holiday
1 PROCEDURE AAIPRC_BJ_100_01 COMPLETED APPLICATION TO. i 100 S0y ¥
2 PROCEDURE TXNACT_B]_100_01 COMPLETED ACCOUNT ACTIVA 1 100 50 ¥ Y
< >
Batch Job Threads
§ vewv Fomat- [ Fresze [l Detach @
Thread Status Errors Records Tracs Level Enabled
1DLE (] (] oy
Request Details
View v Formaty [ Freeze i} Detach Wrap 50
Request Type Status Start Dt End Dt Run Start Dt Run End Dt Process Dt
No data to display.
< >
Request Results
View v Formaty B Freeze  Ef Detach wrap 0]
Request Result Description
> Origination Na data to display.
> Servicing
> Collections
> WFP
> Tools
> Setup

A brief description of the fields is given below:

Table 2-1 Batch Jobs Sets

|
Field: View this:

Set Code Displays the code for batch job set.
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Table 2-1 (Cont.) Batch Jobs Sets
]

Field: View this:

Job Set Description Displays the description for batch job set.

Status Displays the job set status.

Frequency Code Displays the frequency at which the job set is to be
executed.

Frequency Value Displays the value of frequency code chosen for
the job set.

Start Time Displays the start time for the job set.

Enabled Displays if the job set is enabled or not.

Critical Displays if this job set is critical or not.

Last Run Dt Displays the date of last run of the job set.

Next Run Dt Displays the next run date for job set.

Parent Displays the preceding job set.

Dependency Displays the type of dependency on predecessor.

To resubmit a batch job set

Whenever a batch job set fails, it is best to resubmit it after correcting the errors that caused
the failure. Resubmitting a set causes system to re-perform the batch job set and dependent
batch jobs.

To do so, in the Batch Job Sets section, choose the batch job set to resubmit (only a batch job
set with a status of FAILED can be resubmitted), then click Resubmit Job Set button.

The Batch Job screen also allows you to resubmit jobs which are in READY or COMPLETED
or FAILED status if you have access key privileges define for your user responsibility. If
provisioned, then a Force Re-Submit Job Set button is available instead of Resubmit Job
Set button to resubmit the jobs with above status.

The Batch Jobs section lists the batch jobs within a job set. The status, threads, commit
count, dependencies, enabled indicator and the holiday and weekend runtime indicators are
shown for each job.

A brief description of the fields is given below:

Table 2-2 Batch Jobs
]

Field: View this:

Seq Displays the batch job sequence number.

Job Type Displays the batch job request type.

Job Code Displays the batch job request code.

Status Displays the job status.

Job Description Displays the batch job description.

Threads Displays the number of threads used by the job.

Commit Count Displays the number of rows after which auto-
commit is triggered.

Errors Allowed Displays the number of errors allowed.

Weekend Displays if the batch job will execute job on

weekend or not.
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Table 2-2 (Cont.) Batch Jobs

Field: View this:

Holiday Displays if the batch job will execute job on a
holiday or not.

Enabled Displays if the job is enabled or not.

Parent Displays the preceding job.

Dependency Displays the type of dependency on predecessor.

Command Displays the command line for the job.

Rollback Segment Displays the rollback segment for job.

To resubmit a batch job

Whenever a batch job fails, it is best to resubmit it after correcting the errors that caused
failure. Resubmitting a set will cause system to re-perform the batch job.

« Inthe Batch Jobs section, choose the batch job to resubmit (only a batch job with a status
of FAILED can be resubmitted), then choose Resubmit Job Set.

e The Batch Job Threads section displays the status of individual threads.

A brief description of the fields is given below:

Table 2-3 Batch Job Threads

Field: View this:

Thread Displays the name of thread.

Status Displays the status of thread.

Errors Displays the number of errors in the thread.
Records Displays the number of records in the thread.
Trace Level Displays the SQL trace level (0, 1, 4, 8, 12).
Enabled Displays if the job thread is enabled or not.

The Request Details section displays the status and runtimes for each time the selected job
ran.

A brief description of the fields is given below:

Table 2-4 Request Details

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Start Dt Displays the job request is valid from this date and
time.

End Dt Displays the job request is valid till this date.

Run Start Dt Displays the date and time on when the job run
started.

Run End Dt Displays the date and time at which the job run
ended.
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Table 2-4 (Cont.) Request Details

|
Field: View this:

Process Dt Displays the transaction is posted with this General

Ledger effective date.

Description Displays the job request description.

If a particular job requires that a result message be created, then that message appears in the
Request Results section. A message is usually created in the event of an error.

A brief description of the fields is given below:

Table 2-5 Request Results

|
Field: View this:

Request Results Displays the result of job request.

Description

Displays the result details.

2.4.2 Monitoring Jobs

ORACLE

The Monitor Jobs screen provides another view of monitoring all system processes, including
credit bureau requests and payment posting. This screen displays the data in reverse
chronological order of the Run Start Date/Time, whereas the Monitor Batch Jobs screen
provides the historical data about each job and job set.

To Monitor Job Details

1. Click Dashboard > Dashboard > System Monitor > Jobs.

Figure 2-3 System Monitor - Jobs

ORACLE’
Financial Services Lending and Leasing
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Job Results
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RequestResut  Description
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2. Onthe Job screen, you can select any of the following type of jobs which are available in
separate tabs:
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Table 2-6 Job screen
]

Select: System Displays:

Batch Batch jobs (used primarily for the nightly
processes).

Back Ground User submitted requests, such as reports and

payment posting.
Credit bureau requests.

Credit Request

In the Job Details section, select the time frame based on elapsed days. You can select
any of the following options:

Table 2-7 Job Details

. ____________________________________________________________________________|
Select: System Displays:

1 Day All the types of jobs selected in Jobs Type
section in last one-day.

1 Week All the types of jobs selected in Jobs Type
section in last one-week.

1 Month All the types of jobs selected in Jobs Type
section in last one-month.

By Date All the types of jobs selected in Jobs Type
section for specific duration. You can specify a
date range (within 3 months) in Start Dt and End
Dt fields using the adjoining calendar and click
Search.

If you select Failed option in the View section, the system displays failed jobs on the type
and time frame you have selected.

In the Job Details section, you can view the following information about jobs matching the
contents of Job Type, View Last and Failed boxes:
A brief description of the fields is given below:

Table 2-8 Job Details
|

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Job Set Displays the job set code.

Job Displays the job description.

Thread Displays the job thread.

Errors Displays the number of errors.

Records Displays the number of records processed by the

job.

Run Start Date/Time

Displays the job run start date time.

Run End Date/Time

Displays the job run end date time.

Description

Displays the job request description.

Process Dt

Displays the job process date.

Valid Execution Period

Start Date/Time

Displays the job start date/time.

End Date/Time

Displays the job end date time.
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6. Inthe Job Results section, you can view the following information about the Job selected
in Job Details section:

A brief description of the fields is given below:

Table 2-9 Job Results
]

Field: View this:
Request Type Displays the job request type.
Description Displays the job request description.

2.4.3 Monitoring Services

ORACLE

The Services screen allows you to track and maintain the system’s processing services,
including credit bureaus, fax-in and batch job scheduler. The system administrator can start or
stop the service on this screen using the action buttons respectively.

To stop, start or refresh a processing service
1. Click Dashboard > Dashboard > System Monitor > Services.

2. Inthe Services section, you can view the following information about the system’s
processing services:

Figure 2-4 Services

ORACLE
Financial Services Lending and Leasing
i Close
e System Monitor x (3
DashBoard Batch Jobs || Jobs | Serwices || Database Server Log Files | | Parked Transactions | Users
DashEoard
Users Productivity )
System Monitor Services
Producer Analysis View v Formatw [P Freeze i Detach Wrap i @states @set Dstp
Frocess files Service Company Branch Description Status
s ALL AL CREDIT BUREAU SERVICE (EFX TEST FILES)
csv AL AL CREDIT BUREAU SERVICE (EXP TEST FILES)
(=] AL ALL CREDIT BUREAU SERVICE (TUC TEST FILES)
Isc AL AL JOB SCHEDULER
v AL AL 108 SERVICE STOPPED
Pl
» Origination
> Servicing
> Collections
> WEP
> Tools
> Setup

A brief description of the fields is given below:
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Table 2-10 Services

Field: View this:

Service Display the service name.
Company Display the service company.
Branch Display the service branch.
Description Display the service description.
Status Display the service status.

3. Inthe Action section, select the processing service you want to work with and choose one
of the following commands in Action section.

Table 2-11 Action

|
Choose: System:

Status Refreshes (updates) the status of service. The
Service screen does not update the status in real
time. You must choose Status after choosing
Start or Stop to perform that command.

Start Starts the job service.
Stop Stops the job service.

2.4.4 Database Server Log Files

Various processes in the system create reports in different log files with regards to what tasks
they performed and what they encountered (for example, errors, failures, erroneous data and
so on). The Database Server Log files tab lists and describes all such log files within the
system on the database server.

To view a log file on the database server

1. Click Dashboard > Dashboard > System Monitor > Database Server Log Files.

Figure 2-5 Database Server Log Files

ORACLE ABSHEKAR + 1g Signout '
Financial Services Lending and Leasing
@B Svstem Monitor [38] Close:
Batch Jobs ~ Jobs  Services Database Serverlog Files  Parked Transactions  Users =
DashBoard
DashBoard - Database Server Log Files
DashBoard Ve ©10ar O 1k @ Montn OBy Date ey End Dt G Ven O Alert® Debug O Interfaces
Users Productivity -
View v Format = Fresze  EfiDetach Wrap £ ListFiles Download File =
System Monitor e roma & E W = EL
et ol 4 File Name: File Type Fie Size Fie Time
ey 1 xaepre_em_100_02_FMW116_7033506.log fle 159173 08/31/2017 02:28:52 AM -
JSYPRC_EN_000_01_DB12102_6374056.log fle 171338 08/23/2017 07:42:07PM
JSVPRC_EN_000_01_DB12102_7283869.log fle 19897 09/10/2017 10:39:59 AM
f XAELPD_EM_100_02_FMW116_7203340.log fle 46704 03/07/2017 03:50:43 AM
RDNLOG_EW/_100_01_FMW116_7284144.log fle 1108 09/08/2017 06:00:34 AM -
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2. Inthe Database Server Log Files section, you can sort the list of logs to be displayed
based on following options:

« Select the View Last option to display the logs based on elapsed days by selecting 1
Day /1 Week / 1 Month / By Date. If By Date option is selected, you can specify a date
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range (within 3 months) in Start Dt and End Dt fields using the adjoining calendar.
Click Search.

» Select the View option to further filter the list based on the type of logs to be displayed
by selecting Alert / Debug / Interfaces.

Click on E= List Files button to view the list of logged files. A brief description of the fields
are given below:

Table 2-12 List of logged files

Field View this:

File Name Displays the name of file.

File Type Displays the type of file.

File Size Displays the size of file.

File Time Displays the date and time stamp of file.

%

In the File Content section you can view the content of the file selected in the Database

To extract a local copy of debug details, click Download File button and save the

file.

Server Log Files by clicking E Show File button.

To sort the view of file contents, select the order as either Beginning or End and specify
the value for # of Lines to be displayed (default 50).

2.4.5 Parked Transactions

ORACLE

Transactions which are posted when the end of day (EOD) batch job process is running,
receive a temporary status of HOLD. Once the EOD batch process is complete, the system
posts the transactions on hold. These transactions can be thought of as parked transactions.
They are waiting to be processed after the EOD batch process. The status of such transactions
can be viewed in the Parked Transaction screen.

To Monitor parked transactions

Click Dashboard > Dashboard > System Monitor > Parked Transactions.
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Figure 2-6 Parked Transactions
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2. Inthe screen’s View Last section, sort the list of transactions to be displayed based on
elapsed days by selecting 1 Day / 1 Week / 1 Month / By Date. If By Date option is
selected, you can specify a date range (within 3 months) in Start Dt and End Dt fields
using the adjoining calendar. Click Search.

3. If you select Failed in the View section, system displays the failed transactions of the time
frame you have selected.

4. In the Transaction Details section, you can view the following information about the
parked transactions meeting the criteria of the View Last and Failed sections.
A brief description of the fields is given below:

Table 2-13 Transaction Details
|

Field: View this:

Date Displays the transaction date.

Account #: Title Displays the account number and title.
Transaction Displays the transaction

Status Displays the status of transaction
Monetary Displays if the transaction is a monetary

transaction or not.

5. In the Transaction Results section, view the results of transaction in Transaction
Processing Details field.

2.4.6 Monitoring Users

The User Logins section allows you to view all users who have logged on to the system, along
with the log on time stamp and logout time stamp. The information appears in reverse
chronological order of the log on time stamp.

To monitor users who have logged on to the system

1. Click Dashboard > Dashboard > System Monitor > Users.
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Figure 2-7 Users
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2. Inthe User Logins section, sort the list of records to be displayed based on elapsed days
by selecting 1 Day / 1 Week / 1 Month / By Date. If By Date option is selected, you can
specify a date range (within 3 months) in Start Dt and End Dt fields using the adjoining
calendar. Click Search.

A brief description of the fields is given below:

Table 2-14 User Logins
]

Field: View this:

User Displays the user ID.
User Name Displays the user name.
Details Displays the details.

Login Date and Time Displays the login date time for the user.

Logout Date and Time Displays the logout date time for the user.

2.4.7 Monitoring JMS Queues

ORACLE

OFSLL uses MDB infrastructure as an interface for asynchronous communication with
thirdparty integrated applications and all the outgoing communications through all the
interfaces are tracked in JIMS Queues tab.

The JMS Queues tab in System Monitor screen facilitates as a dashboard to monitor the
status of all the configured MDB (Message-Driven Bean) queues and provides a statistics of
the total messages / requests that are sent from OFSLL to external system along with their
status.

The JMS Queues tab has the following sub tabs:

e Status sub tab - to view the last status of configured MDB

* Messages sub tab
— To view the list of configured interfaces and total messages triggered to the interface.
— To view the status of response for the message received from the interface.

— To Re-submit failed messages.

To view the status of all the configured MDB

2-13



2.

3.

Chapter 2
System Monitor

Click Dashboard > Dashboard > System Monitor > JMS Queues. The Status sub tab is
displayed by default.
Figure 2-8 JMS Queues
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ROUTEONEMDE  ROUTEONE INTERFACE MDB

TORQUE ITSMDB  TORQUE ITS INTERFACE MDB RUNNING -

In the Status section, you can view the following details of configured MDB:

Table 2-15 Status

|
Field View this:

Service Displays the name of the message service
suffixed by MDB to differentiate the different
MDB services.

Description Displays the description or abbreviated name of
MDB interface.
Last Updated Status Displays the status of MDB interface. Following

are the status displayed:

¢ UNKNOWN - indicates that no MDB
infrastructure is connected or status ping
message is not sent to that MDB.

¢ SUBMITTED - indicates that a dummy ping
message is sent to MDB.

*  RUNNING - indicates that the message is
consumed by MDB infrastructure.

e« STOPPED - indicates if MDB infrastructure
is down.

In the Status section, select the required service for which you need the status and click

Click & button. On clicking, a dummy ping is sent to the interfaced server and status in
Last Updated Status column is updated as SUBMITTED.

Click L] (refresh) button, to fetch the latest status and the response received is updated in
Last Updated Status column.

To view the messages triggered to all configured MDB

ORACLE
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1. Click Dashboard > Dashboard > System Monitor > JMS Queues > Messages tab.

Figure 2-9 JMS Queues - Messages

ORACLE" # Welcome ABSHEKAR ~ o
Financial Services Lending and Leasing
System Monitor 3 Close
Batch Jobs Jobs Services Database Server Log Files Parked Transactions Users JMS Queues  Events ~
Status  Messages
Company ALL v View Last (O 1 Day(O 1 Week® 1 MonthO By Date ~ Start Dt End Dt )
Messages
&l Detach Wrap (7))
Service Description Submitted Completed Failed Resubmitted
WEBHOOKMDB  WEBHOOK MDB 132 18 104 3
EXP MDB EXP INTERFACE MDB 3 3 0 0
EVENTS MDB EVENTS MDB 145 145 0 0
Message Details [E view
View v Format v [ Freeze [ Detach Wrap W
Message ID Request Type Request SubType  Message Type Status Message Content Time
95F4139888951EB... OUTBOUND EVENTS EVENTACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TY TIY_| |EVENT_TYPE=TXN... 10/28/2019 02:03... A
95F428A97024209... OUTBOUND EVENTS EVENT_ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE: TTY_NBR= |EVENT_TYPE=TXN... 10/28/2019 02:07.
95F642DA4GFS57... OUTBOUND EVENTS EVENT_ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TY TTY_NBR= EVENT_TYPE=TXN... 10/28/2019 04:38.
96067A77EDG07A... OUTBOUND EVENTS EVENT_ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-ASSOCIATE-0... 10/28/2019 11:59.
96067A77ED627A... OUTBOUND EVENTS EVENT_ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-ASSOCIATE-0... 10/28/2019 11:59.
96067A77ED6A7A... OUTBOUND EVENTS EVENT_ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-ASSOCIATE-0... 10/28/2019 11:59.
96067A77EDSE7A... OUTBOUND EVENTS EVENT_ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-001|EVENT_T... 10/28/2019 11:59.
960B86096B66037... OUTBOUND EVENTS EVENT_ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR~20181100045447 | EVENT_TYPE=TXN.... 10/29/2019 06:00.
960B86096B6A03... OUTBOUND EVENTS EVENT_ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=20190100091582|EVENT_TYPE=TXN.... 10/29/2019 06:00.
960B86096B6C03... OUTBOUND EVENTS EVENT_ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR~20190600062140|EVENT_TYPE=TXN... 10/29/2019 06:00... ¥
Response Message Details
View v Format v Freeze [ Detach Wrap @ Viewoption ® BeginningQOEnd  # Of Characters 50 [E] show File  [5] Show Al
Text
No data to display.
< >
v

2. Inthe Messages section, filter the list of messages using the following options:

e Select the required Company from the drop-down list to view JMS message at
company level. The list is populated only with those Company Definitions to which you
have been provisioned access. By default, ALL is selected.

« Select the View Last option to display the messages based on elapsed days by
selecting 1 Day (default) / 1 Week / 1 Month / By Date. If By Date option is selected,
you can specify a date range (within 3 months) in Start Dt and End Dt fields using the
adjoining calendar.

3. The Messages section displays the list of configured interfaces and the total of messages
exchanged between OFSLL and MDB in Submitted, Completed, Failed and Resubmitted

status. Click L2l (refresh) button to update the latest status.

4. Inthe Messages section, you can view the following details:

Table 2-16 Messages

|
Field View this:

Service Displays the name of the message service
suffixed by MDB to differentiate the different
MDB services.

Description Displays the description or abbreviated name of
MDB interface.

Submitted Displays the total count of requests submitted.

Completed Displays the total count of requests completed.

Failed Displays the total count of requests failed.

Resubmitted Displays the total count of only those requests
which are failed and resubmitted again for
processing.

To ‘Re-submit’ failed messages

ORACLE .
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Click Dashboard > Dashboard > System Monitor > JMS Queues > Messages tab.
In the Messages section, select the required MDB interface.

The Message Details section below displays the list of messages sent to the interface with
the following details:

Table 2-17 Message Details
|

Field View this:

Message ID View the system generated MDB message ID

Request Type View the message request type

Request SubType View the message request sub type

Message Type View the message identifier

Status View the message processing status

Response This column data is displayed only for Webhook
MDB.

View the HTTP Header received as response
during Webhook event action invocation.

Message Content View the message content

Time View the message time stamp

In the Message Details section, select the message in Failed status. Click L2 (refresh)
button to update the latest status.

(Optional) You can click View to display the selected record in Message Details section.

Click Re-submit. The details are triggered again for processing and the Resubmitted
counter in Messages section is updated along with other counters.

Response Message Details

This section is enabled if Events or Webhook type of MDB service is selected in Message
section and displays the request Message Details that is propagated to external system for the
posted event action.

To view ‘Response Message Details’ of an Event

1.

3.

Select the required record from the Message Details section and click Show File.
The first 50 characters of the request in json format is displayed since the default
preference selected is Beginning in View option and # of Characters is set to 50.

You can customize the preference using View Option (Beginning / End) and specifying the
number of characters to be displayed.

Also you can click Show All to display the complete request.

2.4.8 Monitoring Events

The Events screen is a dashboard to view all the Events triggered in the system. In the Events
screen you can view the latest status of all the processed events and ‘Re-submit’ only failed
events for re-processing. However, this is a display-only field and does not allow to modify the
defined event action parameters.

ORACLE

The Events screen has the following sections:

Event Actions

Action Parameters

2-16



ORACLE

Chapter 2
System Monitor

In the View Options section, you can filter and view the list of Events based on following
Status:

« ALL

« SUBMITTED

*  WAITING FOR USER INPUT
* COMPLETED

* FAILED
* CRITERIANOT MET
« VOID

In the View Last section, you can further sort the volume of records displayed on the Events
screen with the following options:

Table 2-18 Events

Select: System Displays:

1 Day List of all events posted in last one-day.

1 Week List of all events posted in last one-week.

1 Month List of all events posted in last one-month.

By Date List of all events posted between specific dates.

You can specify a date range (within 3 months) in
Start Dt and End Dt fields using the adjoining
calendar.

To View the Events triggered in the system

1. On the Oracle Financial Services Lending and Leasing home screen, Click Dashboard >
System Monitor > Events tab.

Figure 2-10 Events

ORACLE’ :
Financial Services Lending and Leasing

# Welcome ABSHEKAR o

System Monitor

BatchJobs Jobs Services Database Server Log Files Parked Transactions Users JMS Queues Events

Event Actions
View Options  ALL v
View Last (O 1 Day(O 1 Week(®) 1 Month(O By Date Start Dt End Dt [ )
View v Format~ [ Freeze £ Detach Wrap @ [B Resubmit
Entity Nbr Event Code Event Query Event Action Process Type Failure Count Status Run Dt
LINK_ABHI_INT_0... EVENT TO PROCE... PENDING_EVENT_ACTIONS REQUEST FOR CR... ONLINE 0 FAILED 11/01/2019 03:07... A
LINK_ABHI_INT_0... EVENT TO PROCE... PENDING_EVENT_ACTIONS SEND LETTER ONLINE 0 WAITING FOR US...
LINK_ABHI_INT_0... EVENT TO PROCE... PENDING_EVENT_ACTIONS CREATE REVIEW ... ONLINE 0 WAITING FOR US...
4 LINK_ABHI_INT_0... EVENT TO PROCE... PENDING_EVENT_ACTIONS CREATE WORK OR... ONLINE 0 WAITING FOR US.
ASSO_ABHI_INT_.... EVENT TO PROCE... EVENT_ACC_UPDATE_BATCH_LOAN CREATE REVIEW ... BATCH 0 COMPLETED v
Action Parameters
Viewv Format~v [ Freeze i Detach Wrap o)
Description Value Type Value Required
REQUEST TYPE CONSTANT MANUAL
SOURCE CONSTANT EXP
REPORT CONSTANT FICO
CUSTOMER RELATION USER INPUT

By default, the Events screen displays all events posted in last one day.

In the Event Actions section, view the following information:
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Table 2-19 Event Actions
]

Field: View this:

Entity Nbr Entity Number on which event generated.

Event Code Event Definition Description.

Event Query Event Criteria Definition Description.

Event Action Event Action Description.

Process Type Event processing type as either Online/Batch
fetched from EVENT_PROCESS_TYPE_CD
lookup.

Failure Count Number of times the event processing has failed.

Status Event action with following execution status:
CRITERIA NOT MET
SUBMITTED
VOID
COMPLETED
FAILED
ALL

WAITING FOR USER INPUT

Run Dt Event Action Generation Date and Time.

4. In the Action Parameters section, view the following information:

Table 2-20 Action Parameters
]

Field: View this:

Description Event Action Parameter Description.

Value Type Event Action Input Parameter Type.

Value Value defined for the event action.

Required Y/N indicating if the Action Parameter is
mandatory.

Re-submit Failed Events

In the Events screen you can filter and re-submit only the FAILED status Online Event
Actions for processing. An Event is marked with Failed status when the same could not be
processed in the system due to setup/infrastructure issues. This is an additional option to re-
process the event actions. On resubmitting an event, the Failure Count against the record is
incremented by 1.

However, Resubmit option is not allowed for Webhook and SEND JMS MESSAGE actions
since the same functionality is available in JIMS Queues.

In the Event Actions section, select the required event record listed with status FAILED and
click RE-submit. On triggering the event, the Run Dt column is updated with Event Action
Generation Date and Time. Click Refresh to fetch the latest status.

2.5 Producer Analysis

The Producer analysis screen enables you to view and know the status of all applications
sourced by different Producers.

Navigating to Producer Analysis
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Click Dashboard > Dashboard > Producer Analysis.

Figure 2-11 Producer Analysis

ORACLE" » " s
Financial Services Lending and Leasing
Producer Analysis 3] Close
DashBoard i Select Criteria
Users Productivity
System Monitor S il = = i . i =~ B submit
Producer Analysis Branch ALL[¥] Sales Agent ALL 2] Status & i Submt
Froces ks Region AL [v] Underwriter ALL [¥] Zp z
Producers | Territories Activity || Volume | Mix
> Dealer
+ G
Recent Activity
Boiata o i Last Funded Approved Funded Comments
No data to display.
Recently Approved Applications
Applicant Name  Application # Amt Collateral Desc
No data to display.
4
Recently Funded Applications
Applicant Name Application # Amt Collateral Desc
5 No data to display.
Recent Comments
i Detach =l Wrap
Date Comment Desc
No data to display.
> Origination
> Servicing
> Collections
> WFP
> Tools
> Setup

You can filter producer details based on any or all of the following criteria:

*  Company

e Branch
* Region
e Territory

e Sales Agent
e Underwriter

¢ Funder

You can select the values from the adjoining drop-down list. Click Submit button. System
displays the Producer details satisfying the criteria, you selected.

The following details are displayed under Producer Details section:
*  Producer #

*  Name

Company

* Branch

e Type
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Select the producer you need to view the statistics. The system displays the statistics under
Summary sub tab and the status and sub status of various applications under Applications
sub tab, of the selected producer.

The system displays the following details under Summary sub tab:

* Year

e Total Apps
e Approved

«  Conditioned
* Rejected

¢ Withdrawn

*  Funded

*  Amount

The system displays the following details under Applications sub tab:

*  Company

e Branch
© App#

* Date

o Title

*  Product
» Status

¢ Sub Status

2.6 Process Files

ORACLE

The Process files screen allows you to view the incoming and outgoing files exchanged
between OFSLL and other interfaced systems for processing and also perform a bulk upload of
required files.

The Process files interface also provide information on the type of files uploaded along with
other attributes. In-order to facilitate the process files handling, the following parameters has to
be enabled in Setup > Administration > System > System Parameters screen. For more
information on enabling system parameters, refer to System Parameters section in Setup
Guides.

e CMN_FILE_PROCESS TO LOB
On enabling the above parameter, system stores the incoming / outgoing documents in the
relevant tables and not in the file system.

*  UIX_INCOMING_FILE_PATH

e UIX_OUTGOING_FILE_PATH
On enabling the above two parameters, the incoming and outgoing file path of application
server need to be defined to the required folder path by updating the Parameter Value
which by default is SETME. (For example: /tmp)

* If both the parameter CMN_FILE PROCESS TO LOB and OUTBOUND CALL Q are enabled
(status ='Y"), system automatically handles upload/download of files from Weblogic
configured process files.
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Depending on the CLOB parameter option, if set to Y the incoming/outgoing file directories are
to be manually created in Web Logic server. For details of directories, refer to Creating
Application Home directory section in Database Installation Guide.

This section consists of the following topics:

* Incoming Process File
¢ Proration of Future Account Dues

* Outgoing Process File

2.6.1 Incoming Process File

ORACLE

The incoming process file screen displays the list of files being shared from an external system
along with other attributes such as directory path, file name, type, size, date and status. You
can select the file required and upload it into the system for immediate processing.

Figure 2-12 Process File - Incoming

ORACLE’ ) ) ) NextGenul # Welcome, ABSHEKAR v 1 sign out &
Financial Services Lending and Leasing

a

Process Files x (3 Close

Incoming Process File  Outgoing Process File

Incoming Process File

View v Format v [0 Freeze i Detach Wrap W Sustfiles [Hupload Company AL v
¢0 mm/ddyyyy @
Select Al (] Directory Name  File Name File Type File Size(bytes)  File Date Status
[scratch/ofsll_hom... customer_pmt_extract_ALL_20200302.dat 127205 03/02/2020 NONE

Uploaded Files

View v Formatv [ Freeze  fffi Detach Wrap @ Viewlast O1Day O 2Days O5Days @ All Days [ Download Bad Data [ Download Log Data ~ Company ALL V.

File Name File Type File Dt Status User
SYSTEM_PARAMETERS.DAT FACTORY DATA UPLOAD 04/20/2021 PROCESSED subhash hegde hegde
OJET_MENU_ACCESS.DAT FACTORY DATA UPLOAD 04/19/2021 PROCESSED subhash hegde hegde
ENDPOINT_LEDGER.DAT FACTORY DATA UPLOAD 04/16/2021 PROCESSED subhash hegde hegde
FLS_ACCESS_DETAILS.DAT FACTORY DATA UPLOAD 04/16/2021 PROCESSED subhash hegde hegde
FLS_ACCESS.DAT FACTORY DATA UPLOAD 04/16/2021 PROCESSED subhash hegde hegde
ENDPOINT_LEDGER.DAT FACTORY DATA UPLOAD 04/15/2021 PROCESSED subhash hegde hegde
FLS_ACCESS.DAT FACTORY DATA UPLOAD 04/15/2021 PROCESSED subhash hegde hegde
ENDPOINT_LEDGER.DAT FACTORY DATA UPLOAD 04/14/2021 PROCESSED subhash hegde hegde
ENDPOINT_LEDGER.DAT FACTORY DATA UPLOAD 04/13/2021 PROCESSED subhash hegde hegde
ACCESS_GRID_FUNCTIONS.DAT FACTORY DATA UPLOAD 04/12/2021 PROCESSED subhash hegde hegde %

View the list Incoming Process File
1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming
files.

A brief description of the fields is given below:

Table 2-21 Incoming Process File

Field: Description:

Select All Select this option to select all the listed files.

Directory Name View the directory path where incoming file is
stored.

File Name View the name of the file.
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Table 2-21 (Cont.) Incoming Process File

_________________________________________________________________________________|
Field: Description:

File Type View the type of incoming file. The file type is auto

populated based on ODD (Output Data Definition)
details maintained for the specific file type in
INCOMING_FILE_TYPE_CD lookup.

File Size(bytes) View the size of incoming file.

File Date View the date and time when the incoming file was

placed in the directory.

Status View the status of the file.

Upload Incoming Process File

1.
2.

Click Dashboard > Process Files > Incoming Process File.

In the Incoming Process File section, click List Files. System displays the list of incoming
files. You can click L to refresh the grid data.

In the Company drop-down list, select the portfolio company. Based on the Company
selected, system processes Incoming files. If the company is selected is ALL, system
processes the upload file related to any company.

However, the Company list is populated only with those Company Definitions to which you
have been provisioned access. This company is considered if system is setup to process
batch jobs at Company level. For more information, refer to Appendix - Company Level
GL Date Configuration section.

Select the check box adjacent to the required file and click Upload. You can also click
Select All check box to perform a bulk upload of all the listed files.

The uploaded files are listed in below Uploaded Files section and the status of the files
are changed from Generated to Uploaded. In case of a processing error, the status of the
file is indicated as Processed Error.

This section consists of the following topic:

Uploaded Files

2.6.1.1 Uploaded Files

The uploaded files section displays the list of incoming files uploaded into the system. You can
sort and view the list of files depending on the number of days based on Last 1 Day / 2 Days /

5 Days / All Days. You can click L2 to refresh the grid data.

ORACLE

On selection, you can view the following information:

Table 2-22 Uploaded Files
|

Field: Description:

File Name View the name of file uploaded.

File Type View the type of file uploaded.

File Dt View the date and time when the file was uploaded.

Status View the status of upload.

User View the login ID of User who performed the file
upload.
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In the Uploaded Files section, you can do the following:

* Click Download Bad Data to download the list of uploaded files which had processing
errors due to bad data.

e Click Download Log Data to download a log of all the files uploaded.

e Sort the list of uploaded files based on specific company by selecting the same from
Company drop-down list.

2.6.2 Proration of Future Account Dues

OFSLL has a facility to derive future dated dues on an account using the input file processing
mechanism. This helps to view the future dues on accounts in bulk even before posting on the
account and without generating a mock statement on the account.

Similar to other input files processing, the required Account numbers and Due Dates on which
the due is to be calculated are to be added as individual record in the file and uploaded into the
system by placing in input folder path. For more information on this process, refer to above
section.

The Input file is processed in the system on running the batch job IADPRC_BJ_100_01
(ACCOUNT DUES FILE UPLOAD) in SET-IFP batch job set and to the location as per the
system parameter CMN_FILE_PROCESS_TO_LOB value.

Using an internal function, system calculates the future dated due for the specific Account(s)
and stores the computed values in database table. The same has to be queried to view the
details. The due amount returned by this function is the regular bill amount calculated with
considering any other outstanding dues. This is the proration amount that is posted on the
same account before the next due is generated.

Note that, only ACTIVE status accounts are processed. Else system displays an error
indicating Invalid Account Status.

2.6.3 Outgoing Process File

ORACLE

The outgoing process file section displays the list of files being shared for upload to other
system for processing and allows you to download the required file for inspection.

Figure 2-13 Outgoing Process File

ORACLE’ ) ) . NextGenUl # Welcome, ABSHEKAR v ig sign out &
Financial Services Lending and Leasing

Process Files x (3 Close

Incoming Process File  Outgoing Process File

Outgoing Process File
View v Format v [ Freeze [ Detach Wrap W [B Download  ViewLast O 1Day O 2Days O 5Days @ AllDays company AL v

Select All (J File Name File Type File Date File Size(bytes) Status
Schemia_Redaction_Policies.sal REDACTION POLL... 03/01/2021 236305 GENERATED
Schema_Redaction_Policies.sal REDACTION POLL... 03/01/2021 236305 GENERATED
Schema_Redaction_Policies.sal REDACTION POLL... 03/01/2021 236305 GENERATED
Lnx_bkrp_output_INDIA_20210225_115824.5pr OUTPUT DATA FIL... 02/25/2021 1822 GENERATED
master_customer_business_statement_20210219.dat OUTPUT DATAFIL... 02/24/2021 28 GENERATED
Lnx_bkrp_output_INDIA_20210224_173223.5pr OUTPUT DATA FIL... 02/24/2021 1822 GENERATED
customer_pmt_extract_INDIA_20210219.dat OUTPUT DATAFIL.. 02/24/2021 0 GENERATED
Lnx_bkrp_output_INDIA_20210224_164549.5pr OUTPUT DATAFIL... 02/24/2021 1822 GENERATED
payable_requisition_export OUTPUT DATA FIL... 02/24/2021 5495 GENERATED
producer_stmt 02/24/2021 28 GENERATED -

)00000000s

History

View v Formatv [ Freeze [ Detach Wrap 30}
User Download Dt
RAKESH BOINA 03/01/2021
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You can sort and view the list of files depending on the number of days based on Last 1 Day /
2 Days /5 Days / All Days.

On selection, you can view the following information:

Table 2-23 Outgoing Process File
]

Field: Description:

Select All Select this option to select all the listed files.

File Name View the name of upload file.

File Type View the type of file shared for upload. The file type

is auto populated based on ODD (Output Data
Definition) details maintained for the specific file
type in OUTGOING_FILE_TYPE_CD lookup.

File Date View the date and time when the file was shared
for upload.

File Size(bytes) View the size of upload file.

Status View the status of upload file.

Download Outgoing Process File

1. Click Dashboard > Process Files > Outgoing Process File.
System displays the list of files shared for upload. You can click L to refresh the grid data.
2. Inthe Company drop-down list, select the portfolio company. Based on the Company
selected, system processes Incoming files. If the company is selected is ALL, system
processes the download file related to any company.
However, the Company list is populated only with those Company Definitions to which you
have been provisioned access. This company is considered if system is setup to process
batch jobs at Company level. For more information, refer to Appendix - Company Level
GL Date Configuration section.

3. Select the check box adjacent to the required file and click Download. You can also click
Select All check box to download all the listed files.

History

The history section displays the following details:

Table 2-24 History
]

Field: Description:

User View the login ID of User who downloaded the file.

Download Dt View the date and time when the file was
downloaded.
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Wholesale Floor Planning

Wholesale Floor Planning (WFP) is an individual module within the Oracle Financial Services
Lending and Leasing Lending. WFP enables a financial institution, mainly vehicle finance
companies, to offer and manage lines of credit to its producers.

With WFP, the financial institution can manage and post transactions at three levels:
e Unit
e Credit Line

e Producer.

You can offer financing to producers as a line of credit and each producer can have multiple
credit lines.

The credit line is an open-ended loan. Producers can finance multiple units per line of credit.
A unit is an asset. Each unit has a set number of terms.
This section consists of the following topics:

«  WFP Maintenance Screen
e Assumptions
* Restrictions

* Note

3.1 WFP Maintenance Screen

The Wholesale Floor Planning Maintenance screen records and maintains all details about the
producers, credit lines extended to the producers, and unit level details of all loans extended
under a credit line. This screen enables you to:

*  View the current producer, credit line, and unit level information

e Set up new producers and record information for new credit lines and the units funded
under these credit lines

« Enter manual transactions at the producer, credit line, and unit level

Performs such operations as rescheduling and changing rates at unit level.

3.2 Assumptions

ORACLE

This document assumes the following:

e The usual Oracle Financial Services Lending and Leasing setup is complete in all respects
and system defined data is already populated in the database.

< Allfields on the Wholesale Floor Planning forms accept data only in the defined format. For
example, the Date field only accepts input in the MM/DD/YYYY format. Percentage fields
accept numbers less than 100. The acceptable format would be mentioned in the hint in
case user keys in a unacceptable format.
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At least one instrument is available for each producer, that is, either the instrument
company/ branch should match the producer company/ branch or an instrument having
company / branch = ALL/ ALL should be defined in setup.

The payoff quote computation is based on current outstanding balances plus interest
payable up to the payoff quote date. It assumes that there would be no other receivables
such as late fees, servicing fees and other fees.

3.3 Restrictions

The Wholesale Floor Planning module does not take into account the late fees, servicing fees
and other fees in computing a Payoff quote.

3.4 Note

ORACLE

The following will not be shown on Unit Assets page (Units link) or Units master page:

Effective date
Valuation date
Source

Usage

Usage value
Add-ons

MSRP

Title release date

Total value.

However, the fields would be retained in the database for possible future use.
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Producers

This section consists of the following topics:

Introduction

Producers

4.1 Introduction

The sections under the Producers screen allows you to maintain producer level activities and
transactions.

The Producer master page displays summary information for a specific producer, including the
address of producer and financial summary of the wholesale credit that is extended. It appears
on the screens opened from the following links under Producers section:

Balances
Transactions
Credit Lines
Statements
Comments
Tracking Attributes
Audits

4.2 Producers

To view the Producer screen

ORACLE

1.

On the Oracle Financial Services Lending and Leasing home page, click the WFP master
tab.

Click the Producers bar link.

Select the status of the producer you want to work with.

Figure 4-1 WFP - Producers

4-1



ORACLE

This section consists of the following topics:

Table 4-1 Producers

Chapter 4
Producers

If you click this:

Financial Services displays:

Active

The active producers.

View All

Both the active and inactive producers.

On the Producers master page, select the record you want to work with and click View.

On the Producer master page, view the following information:

Table 4-2 Producer master page

In the field:

View this:

Producer

The producer number and name. By default, only
active producers are displayed.

Total Credit Limit

The sum total of all credit lines extended to the
producer. This field is O for inactive producers.

New Status The status of the producer in WFP module:
ACTIVE or INACTIVE. ACTIVE indicates the
producer has open lines of credit or outstanding
unit loans.

Address The address of the selected producer.

Analyst The name of the analyst who activated producer

in WFP module.

Total Suspended Amt

The sum of the suspended amount for all credit
lines, or amount from credit limit that will not be
available. This is a means of temporarily
reducing the credit limit.

Advance Balance

The current balance of advance outstanding with
the producer.

Available Credit

The current available credit limit. The available
credit equals total credit less the suspended
amount less advance balance.

Approval Dt The date on which the producer status changes
to ACTIVE or INACTIVE.

Pre Bill Days The number of days before due date when the
statement would be generated.

Pmt Due Day The day of the month when payment is due.

Last Pmt Dt The date on which the last payment was made.

Last Pmt Amt

The amount received in the last payment made
by producer.

Last Bill Dt The date when the last billing statement was
generated.
Next Bill Dt The date when the next billing statement will be

generated.

Balances sub tab
Transactions sub tab
Credit Lines sub tab

Comments sub tab

Tracking Attributes sub tab
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e Audit sub tab

4.2.1 Balances sub tab

ORACLE

The Producer Balances sub screen displays producer level balance information.

To view the Producer Balances screen
On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Producers > Balances

Figure 4-2 WFP - Balances
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1. On the Producer screen, select the record you want to work with.

2. Inthe Producer Balances screen’s Balances section, select the record you want to work
with.

3. Inthe Balances section, view the following information:

Table 4-3 Balances section
|

In the field: View this

Type The description of balances type.

Amount The balance due from the producer.

Paid The balance paid by the producer.

Waived The balance waived by the financial institution.

Charge Off The balance charged-off by the financial
institution.

Recovered The recovered charged-off balance.

Outstanding The balance that is still due from the producer.

The outstanding balance equals the amount
minus the paid amount minus the waived amount
minus the charged-off amount minus the
recovered amount.

(Optional) Enter the result of the procedure here.
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4.2.2 Transactions sub tab

ORACLE

The Producer Transactions screen enables you to view past producer level transactions.
Based on WFP set up, certain transactions can also be reversed.

To view the Producer Transactions screens
On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Producers > Transactions.

1. Onthe Producer screen, select the record you want to work with.

Figure 4-3 WFP - Transactions
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In the Sort By section, choose Post Dt to sort the entries in Transactions section in order
of when transaction was created.
_Or_

Choose Txn Dt to sort the entries in Transactions section in order of when the transaction
occurred.

_Or_
2. Select View All to view all transactions.

3. Inthe Producer Transactions page’s Transactions section, select the record you want to
work with.

4. In the Transactions section, view the following information:

Table 4-4 Transactions section
]

In this field: View this:

Post Dt The post date of the transaction.
Txn Dt The effective date of the transaction.
Transaction The description of the transaction.
Amount The transaction amount.

Reason The reason for the transaction.
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Table 4-4 (Cont.) Transactions section

|
In this field: View this:

Comment The comment for the transaction.

To reverse a transaction

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Producers > Transactions.

On the Producer master page, select the record you want to work with

In the Sort By section, choose Post Dt to sort the entries in Transactions section in order
of when transaction was created.
_or_

Choose Txn Dt to sort the entries in the Transactions section in order of when the
transaction occurred.

_Or_

Not all transactions can be reversed. If a transaction cannot be reversed, the Reverse
button is dimmed when the transaction is selected.

Select View All to view all transactions. Reversed transactions do not appear on the
Transactions section when the View All box is cleared.

In the Producer Transactions screen’s Transactions section, select the transaction you
want to reverse. (You may have to search to find the transaction).

10. On the Producer Transactions screen, click Reverse.
11. In the Transactions section, select All Txns to view the reversed transaction.

(Optional) Enter the result of the procedure here.

4.2.3 Credit Lines sub tab

ORACLE

The Producer Credit Lines screen displays a summary of the credit lines extended to producer.
The Units section displays summary information of each unit funded with the selected credit

To view the Producer Credit Lines sub screen

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Producers > Credit Lines.
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Figure 4-4 WFP - Credit Lines
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2. Onthe Producers screen, select the record you want to work with.

3. Inthe Producer Credit lines screen’s Credit Lines section, select the record you want to
view.

4. Inthe Credit Lines section, view the following information:

Table 4-5 Credit Lines section

|
In this field: View this

Producer Name The name of the producer.

Credit Line The description of the credit line.

Type The unit type associated with the credit line.

Total Credit Limit The total credit limit for the credit line.

Suspended The amount of the credit line that is suspended
(not available for disbursement).

Available The available credit for the credit line.

Enabled If selected, the credit line is enabled.

Start Dt The start date of the credit line.
End Dt The end date of the credit line.

# Note:
An empty field indicates that the line is active.

5. In the Units section, select the record you want to view.

6. In the Units section, view the following display only information:

Table 4-6 Units section

'
In this field: View this

Unit # The unique number of the unit loan

ORACLE 46



Chapter 4
Producers

Table 4-6 (Cont.) Units section
|

In this field: View this

Status The status of the unit loan; either ACTIVE or
INACTIVE.

Contract Dt The date when the contract was signed

Advance Amt The value of loan advanced for financing the
asset

Funded Dt The date when the unit was funded.

First Pmt Dt The date when the first payment would be due
from producer.

Maturity Dt The date when the loan matures and is expected
to be paid back in full.

Total Term The term of the loan for unit, in months.

# Note:

If you select View All, Oracle Financial Services Lending and Leasing displays
all units with all status, including the active ones, in the Units section. When a
unit is paid off, its status changes and you'll have to choose View All to view it
here.

Statements sub tab
The display only Producer Statements page displays a history of the monthly statements
generated for the producer in reverse chronological order.

To view the Producer Statements sub screen

1. On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Producers > Statements.

Figure 4-5 WFP - Statements
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2. Onthe Producer master page, select the record you want to work with.

3. Inthe Producer screen’s Statement section, select the record you want to view.
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In the Producer Transactions section, view the following display only producer level
information about the selected statement.

Table 4-7 Producer Transactions section

|
In this field: View this:

Total Due The total amount due from producer as of the
current statement. The total due equals the sum
(total due for all credit lines) plus producer level
transaction total.

Txn Total The total of producer level transactions as of the
statement date. The transaction total equals the
sum of total due for all producer level
transactions.

Type The descriptions of the producer level transaction
type.

Current Due The amount due for specified transaction type
during the current statement period.

Past Due The unpaid value due for specified transaction
type for all the past statements.

Total Due The value total due for the specified transaction
type.

The Credit Line Transactions section contains two table records: one on the top lists credit
lines for the producer and one on the bottom lists transaction details for a particular credit
line. These sections have a parent - child relationship. In this case, what transactions
information appears in the table record on bottom depends on what credit line is selected
in the top.

In the Credit Line Transactions section, select the record you want to view.

In the Credit Line Transactions section, select credit line you want and view the following
display only information:

Table 4-8 Credit Line Transactions section
]

In this field: View this

Select If selected, indicates this is the current record.
Credit Line The credit lines offered to the producer.

Total Due The total amount due for credit line as of the

current statement. The total due equals sum of
transaction total for all units under the credit line
plus credit line level transaction total.

Txn Total The total of credit line level transactions as of the
statement date.The transaction total equals the
sum of total due for all transactions of a credit
line.

In the Credit Line Transactions section, view the following credit line level transaction
information for credit line you selected in the previous step.

# Note:

There may be more than one transaction listed.
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Table 4-9 Credit line level transaction

In this field: View this:

Type The description of the credit line transaction.

Current Due The amount due for specified credit line
transaction type during the current statement
period.

Past Due The unpaid dollar amount due for specified credit
line transaction type for all the past statements.

Total Due The dollar amount total due for the specified

credit line transaction type (current plus past).

The Unit Transactions section contains two table records: the one on the top lists units for
the credit line selected in Credit Line Transactions section, the one of the bottom lists
transaction details for a particular unit. These sections have a parent - child relationship.

In the Unit Transactions section, select the record you want to view.

In the Unit Transactions section, select the unit you want and view the following
information:

Table 4-10 Unit Transactions section

In this field: View this

Select If selected, indicates this is the current record.
Unit # The unique unit number.

Txn Total The total of unit level transactions as of the

statement date. The transaction total equals the
sum of total due for all transactions for a unit.

In Unit Transactions section, view following unit level transaction information for the unit
you selected in the previous step.

Table 4-11 Unit level transaction information

In this field: View this
Type The description of the balance type.
Current Due The amount due for specified unit transaction

type during the current statement period.

Past Due The unpaid dollar amount due for specified unit
transaction type for all the past statements.

Total Due The total dollar amount due for the specified unit
transaction type (current + past).

4.2.4 Comments sub tab

ORACLE

The Producer Comments sub screen enables you to enter new comments regarding the

producer. Oracle Financial Services Lending and Leasing saves and displays previously

1.

entered comments in reverse chronological order.

To add or view a comment attached to a producer

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Producers > Comments.
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2. Inthe Producer master screen, select the producer you want to work with.

3. Inthe Producer Comments section, select the record you want to work.

# Note:

If you are entering a new record, click Add.

4. In the Currency section, enter or view the following information:

Table 4-12 Currency section

In this field: Do this:

Type Select the comment type. This field notes the
nature of the comment and can help in
classifying comments (required).

Sub Type Select the comment sub type. This field also
notes the nature of the comment and can help
further classify comments (required).

Comments Enter the comment details (required).

Comment By* View the user id of who posted the comment
(display only).

Comment Dt* View the date and time that the comment was

posted (display only).

5. Click Save on the Producer Comments page.

*Oracle Financial Services Lending and Leasing notes the user who entered this comment
and the time it was saved.

4.2.5 Tracking Attributes sub tab

Using the Producer Tracking Attributes sub screen, you can add tracking attribute information
to a producer at any time.

To add or view a tracking attributes attached to a producer
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1. On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Producers > Tracking Attributes.

Figure 4-7 WFP - Tracking Attributes
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2. Inthe Producer screen, select the producer you want to work with.
3. Inthe Producer Tracking sub screen, click Load Tracking.

Oracle Financial Services Lending and Leasing loads the tracking parameters.
4. Inthe Tracking Attributes section, select the record you want to view or edit.

5. To update a tracking attribute, click Edit and enter the requested parameter in the Value
field.

Click Save and Add to add a new record. Click Save and Return to return to main screen.

4.2.6 Audit sub tab

If an audit is set for a record, then the system tracks the changes for that record. Select the
record for which you want to view the audit info and click Audit tab. The system displays the
details tracked for that record.

To view the log report of a record attached to a producer

1. On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Producers > Audit.

2. Inthe Producer screen, select the producer you want to work with and click Audit.

The system displays the following details of the selected record:

Table 4-13 Audit sub tab
]

In this field: View this:

Record Id The ID of the selected record.

Field The amended field name.

Old Value The old value of the field.

New Value The changed value of the field.

Changed By The name of user who changed the value.
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Table 4-13 (Cont.) Audit sub tab

|
In this field: View this:

Changed Dt The date when the value was changed.
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This section consists of the following topics:

Introduction
Credit Lines Screen

Transaction sub tab

5.1 Introduction

The screens in Credit Lines allows you to enter and maintain credit lines for producers who are
set up in the WFP module. Each line of credit contains multiple units.The Credit Line screen
displays summary information for a specific producer, including the address of producer and
financial summary of the wholesale credit that is extended. The sub sections under the credit
line section are:

Balances
Transactions
Credit Limit History
Units

Comments
Tracking Attributes
Audits

5.2 Credit Lines Screen

To view the Credit Lines screen:

ORACLE

1.

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Credit Lines.

Figure 5-1 WFP - Credit Line Screens

In the Producers Tab, select the producer you want to work with.

In the Credit Lines screen, select the record you want to work with and click View in the
Details column.
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» If you choose, use Search Criteria to limit the display of credit line records.

» If you select View All, Oracle Financial Services Lending and Leasing
displays both active and inactive credit lines.

In the Credit Lines master page, view the following display only information:

Table 5-1 Credit Lines master page

In this field: View this:

Credit Line The description of the credit line.

Type The unit type associated with the credit line.
Total Term The term of loan extended under the credit line in

months. This will be same for all units funded
under the credit line.

Accrual Start Days

The number of days from the day a loan is
extended under credit line after which interest
rate accrual starts.

Total Credit Limit

The credit limit of the credit line. This is the same
value as the contents of Total Credit Limit field
above in Credit Lines section on Credit Lines

page.

Advance %

The percent of the value of each unit that would
be extended as a loan. If the credit line is for
NEW VEHICLES, then value of loan usually
equals vehicle value; for example, the advance
percent equals 100 percent.

Prior Curtailment %

The percent of principal recovered per month in
the prior year.

Current Curtailment %

The percent of principal for the current year.

Margin Index

The index that would be used for setting the
interest rate on unit loans.

Margin Rate

The number to be added to the index rate to
arrive at the interest rate.

Curtailment Start Months

The number of months after which loan
curtailment (principal repayment) starts.

First Pmt Start Months

The number of months after which the first
payment would be due for a unit loan extended
under credit line.

Ceiling Index

The index that would be used for setting the
interest rate ceiling on unit loans.

Ceiling Rate The number to be added to the ceiling index rate
to arrive at the ceiling interest rate.

Start Dt The start date of the credit line.

End Dt The end date of the credit line.If it is empty
shows that line is active.

Suspended The dollar amount of the credit line that is

suspended (not available for loan).
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Table 5-1 (Cont.) Credit Lines master page

|
In this field: View this:

Available The dollar amount of credit utilized by the
producer. The available credit equals the credit
limit minus suspended limit minus outstanding

advance.
Outstanding Advance The total outstanding advance amount.
Outstanding Interest The total outstanding interest on advance
amount.
Outstanding Fees The total outstanding fees on advance amount.
Total The total outstanding amount including advance

amount, interest and fees.

This section consists of the following topic:

e Balances sub tab

5.2.1 Balances sub tab

The Credit Line Balances sub tab enables you to view the type of credit line balance and its
amounts paid, waived, charged-off, recovered, and outstanding.

To use the Credit Line Transaction sub tab

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Credit Lines > Balance.

For more details on Balances refer section Balances sub tab in Producers chapter.

5.3 Transaction sub tab

ORACLE

The Credit Line Transactions sub tab enables you to post new credit line transactions and view
past transactions. Transactions can be both monetary (for example, a credit line audit fee) and
nonmonetary (such as suspending a credit line). Based on WFP setup, certain credit line
transactions can also be reversed with the Credit Line Transactions page.

To use the Credit Line Transaction sub tab

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Credit Lines > Transactions.

For more details on Transaction refer section Transactions sub tab in Producers chapter.
Reversing a Transaction

The following unit level monetary transactions can be reversed:

« Late Charge transactions with the actions CHARGE-OFF and WAIVE

e Unit Other Fee transactions with the actions POST, CHARGE-OFF, and WAIVE

e Unit Service Fee transactions with the actions CHARGE-OFF and WAIVE

* Interest and Principal transactions with the actions CHARGE-OFF and WAIVE

* Rate Change, Reschedule, Unit Activation, Unit Charge-off, and Unit Paid off transactions
with the action Post.

To reverse a transaction
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On the Oracle Financial Services Lending and Leasing home page, click the WFP tab.
Click the Credit Lines bar link.
In the WFP Maintenance link bar, click the Credit Lines drop-down link, then click
Transactions.
In the Producers tab, select the producer you want to work with.
In the Credit Lines tab, select the credit line you want to work with.
In the Credit Line Transactions tab’s Transactions sub tab, select the record you want to
reverse.
In the Transactions tab, click Reverse.

¢ Note:

* Not all transactions can be reversed. If a transaction cannot be reversed, the
Reverse button is dimmed when the transaction is selected.

e Reversed transactions do not appear on the Credit Line Transactions page’s
Transaction section when the View All box is cleared.

This section consists of the following topics:

Credit Limit History sub tab
Units sub tab

Comments sub tab
Tracking Attributes sub tab
Audit sub tab

5.3.1 Credit Limit History sub tab

The Credit Limit History sub tab enables you to view the older credit lines of a producer in the
WFP module.

ORACLE

To view the Credit Limit History sub tab:

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Credit Lines > Credit Limit History.

1.

In the Credit Limit History sub screen, Add or View the following information:

Table 5-2 Credit Limit History

In this field: Do this:

Commitment The credit limit committed to the producer.
Action The action that was performed.

Reason The reason why the credit limit was changed.
Analyst The name of analyst who authorized /altered the

credit limit. As this information comes from an
optional field, it may be blank.

Change Dt The date when the credit limit was altered.
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5.3.2 Units sub tab

The Credit Line Units sub tab displays details of the units that are funded through credit line

selected on Credit Lines screen.
To view the Credit Line Units sub tab

1.

o & W Db

5.3.3 Comments sub tab

Chapter 5
Transaction sub tab

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >

Credit Lines > Units.

In the Producers tab, select the producer you want to work with.

In the Credit Lines tab, select the credit line you want to work with.

In the Credit Line Units sub tab, select the record you want to view.

In the Units sub tab, view the following information:

Table 5-3 Units sub tab

In this field: Do this:

Select If selected, indicates that this is the current
record.

Unit # The unique number of the unit loan.

Status The status of the unit loan; either ACTIVE or

INACTIVE.

Contract Dt

The date when the loan contract was signed.

Advance Amt

The amount of loan given for financing the asset.

Funded Dt The date when the unit was funded

First Pmt Dt The date when first payment would be due from
the producer.

Maturity Dt The date when the loan matures and is expected
to be paid back in full.

Total Term The term of the loan for unit, in months.

The Credit Line Comments sub tab enables you to view or enter new comments regarding the
credit line. Oracle Financial Services Lending and Leasing saves and displays previously

entered comments in reverse chronological order.

To view the Credit Line Comments sub tab

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >

Credit Lines > Comments.

For more details on Comments refer section Comments sub tab in Producers chapter.

5.3.4 Tracking Attributes sub tab

When using WFP, you can add tracking attribute information to a credit line at any time using

the Credit Line Tracking Attributes page.

To add or view a tracking attributes attached to a credit line

ORACLE
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On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Credit Lines > Tracking Attributes.

For more details on Tracking Attributes refer section Tracking Attributes sub tab in
Producers chapter.

5.3.5 Audit sub tab

ORACLE

If an audit is set for a record, then the system tracks the changes for that record. Select the
record for which you want to view the audit info and click Audit tab. The system displays the
details tracked for that record.

To view the log report of a record

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Credit Lines > Audit.

For more details on Audit, refer section Audit sub tab in Producers chapter.
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Units

This section consists of the following topics:

Introduction

Units Screen

6.1 Introduction

The pages opened from the Units drop-down link allow you to enter and maintain asset units
funded under a credit line for producers who are set up in the WFP module. With the Units
master page you can select a producer in the Producers section and view its extended lines of
credit in Credit Lines section, then view the units funded with that credit line. It appears at top
of pages opened from the following links on the Units drop-down link:

Details
Maintenance
Asset
Transactions
Balances
Comments
Verification

Tracking Attributes

6.2 Units Screen

To view the Units screen

ORACLE

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Units.

1.
2.

In the Producers master page, select producer with the units you want to work with.

In the Credit Lines master page, select active credit line with the units you want to work
with.

In the Units master page, select the unit you want to work with.

# Note:

Select the View All check box to view both active and inactive units.

In the Units screen, view the following display only information:
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Figure 6-1 WEFP - Unit Screen

Table 6-1 Units screen

Chapter 6
Units Screen

In this field: Do this:
Unit # The unique number of the unit loan.
Status The status of the unit loan, either ACTIVE or

INACTIVE.

Contract Dt

The date when the contract was signed.

Advance Amt

The loan amount advanced for financing the
asset.

Funded Dt The date when the unit was funded.

First Pmt Dt The date when the first payment would be due
from the producer.

Maturity Dt The date when the loan matures and is expected
to be paid back in full.

Total Term The term of the loan for unit, in months.

This section consists of the following topics:

e Units Details

e Balances Sub tab

e Transaction sub tab

«  Payoff Quotes sub tab

e Rate Change sub tab

e Reschedule Change sub tab
e Status Change sub tab

e Conditions sub tab

* Assets sub tab

«  Comments sub tab

e Tracking Attributes Sub tab
* Audits sub tab

6.2.1 Units Details

The Unit Details section enables you to set up the details of new units funded under a credit

ORACLE

line. Initially, status of the unit is PENDING.

The Unit Details page enables you to view contract details for unit when the unit was funded. It
also displays the current contract details for the same unit.

To view the Units Details page
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On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >

Units.

In the Units section click the Add to specify the details. In Producers master page, select

the producer with units you want to work with.

In the Credit Lines master page, select active credit line with the units you want to work

with.

In the Units master page, select the unit you want to work with.

In the Unit Details section, enter, view, or edit the following information:

Table 6-2 Unit Details section

In this field: View this:

Unit# The unique number of the unit loan.

Status View the status of the unit

Contract Dt The date when the contract was signed.

Instrument The type of instrument under which the funding
was done.

First Pmt Dt The date when the first payment would be due.

Maturity Dt The maturity date of the loan.

Total Term The term of the loan for unit, in months.

Advance% Enter the advance percent of the unit loan

Advance Amt

The amount that was extended as a loan for
funding the unit.

Curtailment%

The currently applicable curtailment percent.

Curtailment Start Dt

The date when the curtailment would start for the
loan.

Accrual Dt Start

The date when the interest accrual would begin
for the unit funded.

Unit Group Number

The Unit group number applicable.

Index Type

The type of index applicable for computing the
applicable interest rate. By default, the Index
Type selected in the Credit Line section is
populated here.

Index Rate

The currently applicable index rate for the type
selected above.

Margin Rate

The currently applicable margin rate to be added
to index rate to arrive at the interest rate.

Total Rate

The sum of the index rate and margin rate.

Ceiling Index Type

The type of index applicable for computing a
ceiling interest rate.

By default, the Ceiling Index Type selected in the
Credit Line section is populated here.

Ceiling Index Rate

The currently applicable ceiling index rate for the
type selected above.

Ceiling Margin Rate

The currently applicable ceiling margin rate to be
added to the Ceiling index rate to arrive at ceiling
interest rate.

Total Ceiling Rate

The sum of the ceiling index rate and ceiling
margin rate.
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6.2.2 Balances Sub tab

The Unit Level Balances sub screen enables you to view the type of unit level balance and its
amounts paid, waived, charged-off, recovered, and outstanding.

To view the unit level balances screen

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Units > Balances.

For more details on Balances refer section Balances sub tab in Producers chapter.

6.2.3 Transaction sub tab

The Units Maintenance page enables you to:
* Enter a new unit level transaction

e Compute and save new payoff quotes

* Apply a new rate change

* Reschedule the term of the unit

e Change the status of the unit

« Change the condition of the unit.

To enter a new unit

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Units > Transactions.

For more details on Transactions refer section Transactions sub tab in Producers chapter.

6.2.4 Payoff Quotes sub tab

ORACLE

The Payoff Quotes section lists all past saved payoff quotes provided to the producer for
paying off the unit selected in the top section. Payoff quotes appear in the reverse
chronological order based on quote date.

To generate a hew pay off quote

1. On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Units > Payoff Quotes.

2. Inthe Producers section, select the producer with the units you want to work with.

3. Inthe Credit Lines section, select the active credit line with the units you want to work
with.

4. In the Units section, select the unit you want to work with.

5. The Units Maintenance page’'s New Payoff Quote section enables you to generate a
new payoff quote.

New Payoff Quote section enables you to compute the amount to be collected from
producer in case the producer wants to repay loan before actual term of the loan is
complete.

6. Inthe New Payoff Quote section, enter the following information:
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Table 6-3 New Payoff Quote section
|

In this field Do this

Last Service Dt Enter the date when the unit was last serviced
(required).

Quote Dt View the payoff quote date (required).

PayOff Amt Enter the payoff amount (required).

Provided To Enter the name of the person to whom the payoff
quote is provided (required).

Last Accrual Dt Enter the last date when interest was accrued on
the loan (required).

PayOff Dt Enter the date when the producer wishes to

payoff the loan (required).

(Oracle Financial Services Lending and Leasing
populates this field when you choose the
Compute button) (required).

Quote Amt Enter the amount actually quoted to the producer
so as to payoff the loan.This could be the same
as or different than the payoff amount (required)

Balance Enter the outstanding loan amount (required).

Click View to view in the Payoff Quotes section the payoff amount based on the balance
due, last accrual date, last service date and payoff date.

Choose Save Quote and Add to save the quote given to producer in the Payoff Quotes
section on Unit Details page (Details link) and add a new record.

Click Save Quote and Return to save the quote given to producer in the Payoff Quotes
section on Unit Details page (Details link) and return to main screen.

6.2.5 Rate Change sub tab

Oracle Financial Services Lending and Leasing applies the rate change to the amounts on
Units Balances (Balances link) and Units Transactions (Transactions link) pages.

To change the interest rate for a unit
On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Units > Rate Change.

1.
2.

ORACLE

In the Producers section, select the producer with the units you want to work with.

In the Credit Lines section, select the active credit line with the units you want to work
with.

In the Units section, select the unit you want to work with.

The Units screen’s Rate Change section enables you to change to rate applicable to the
unit.

In the Rate Change section, enter the following information:

Table 6-4 Rate Change section
|

In this field Do this

Margin Rate Enter the new margin rate to be applied on the
index rate.This cannot be a negative number
(required).
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6.2.6 Reschedule Change sub tab

To reschedule the term for the unit

ORACLE

5.

1.

Table 6-4 (Cont.) Rate Change section

Chapter 6
Units Screen

In this field

Do this

Index Type

Select the new index type (required).

Effective Dt

The date from when the new rate is applicable.
This is either:

Nothing less than the last billing date

-or-

The contract date for the unit, whichever is
greater.

It cannot be a future date (required).

Reason Select the reason for the rate change (required).

Comment Enter any comments related to the rate change
operation (required).

Index Rate Enter the index rate applicable for the selected
index type (display only).

Total Rate Enter the new interest rate for the unit. The total

rate equals the index rate plus the margin rate.

This is rate applicable for interest computation for
the units (display only).

In the Rate Change section, click Apply button to apply new rate on the unit.

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >

Units > Reschedule Change.

In the Producers section, select producer with the units you want to work with.

In the Credit Lines section, select active credit line with the units you want to work with.

In the Units section, select the unit you want to work with. The Reschedule Change
section enables you to reschedule the term of the unit.

In the Reschedule section, enter the following information.

Table 6-5 Reschedule section

In this field

Do this

New Term

Enter the new term of the loan.The new term
should not be less or equal to the term elapsed
for loan as of current date. For example: If the
term was initially 24 months and if the
rescheduling is happening after 12 months, then
the new term cannot be 12, since 12 months
have already elapsed (required).

Existing term

View the existing term of the unit (display only).

Reason Select the reason for schedule change
(required).
Comment Enter any comments related to the rescheduling

operation (optional).
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6.2.7 Status Change sub tab

To change the status of a unit

ORACLE

6.

1.

Table 6-5 (Cont.) Reschedule section
|

In this field

Chapter 6
Units Screen

Do this

Curtailment %

Enter the new curtailment percent. Making back
dated changes to the curtailment percentage or
term results in Oracle Financial Services Lending
and Leasing computing all the balances based
on new interest rate from the date when new rate
and term becomes effective (required).

Effective Dt

The date from when the new rate is applicable.
This is either:

Nothing less than the last billing date

-or-

The contract date for the unit, whichever is
greater.

This cannot be a future date (required).

In the Reschedule section, click Apply to apply the new schedule on the unit.

Oracle Financial Services Lending and Leasing displays the updated schedule in the
Current section of the Unit Details page (Details link).

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >

Units > Status Change.

In the Producers section, select the producer with the units you want to work with.

In the Credit Lines section, select the active credit line with the units you want to work

with.

In the Units section, select the unit you want to work with.

The Status Change section allows enables you to change the status of the unit.

The following are the possible status change combinations:

Table 6-6 Status change combinations
________________________________________________________________________________|

From Status To Status Validations/prerequisites

PENDING ACTIVE None

PENDING VOID None

ACTIVE CHARGE OFF None

ACTIVE PAID Balances should be zero or less
than the tolerance

ACTIVE PENDING There should be no payments
against the Unit. Making the unit
status pending would make all
the balances zero.

PAID ACTIVE None

CHARGE OFF ACTIVE None
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# Note:

Once the status becomes VOID, it cannot be changed to any other status.

In the Status Change section, enter the following information:

Table 6-7 Status change section
|

In this field Do this
New Status Select the new status for the unit (required).
Effective Dt Enter the effective date of status. This defaults to

current date. This cannot be less than:

The last billing date

-or-

The unit contract date, whichever is greater.
This cannot be a future date (required).

Reason Select the reason for changing the status of the
unit (required).

Comment Enter any comments related to the status change
(optional).

In the Status section, click Post to apply the new status on the unit.

6.2.8 Conditions sub tab

Oracle Financial Services Lending and Leasing changes the condition of the unit on the WFP
screen.

ORACLE

To change the condition of a unit

1.

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Units > Conditions.

In the Producers section, select the producer with the units you want to work with.

In the Credit Lines section, select the active credit line with the units you want to work
with.

In the Units section, select the unit you want to work with.
The Condition section enables you to change the condition of the unit.

In the Condition section, enter the following information:

Table 6-8 Condition section
|

In this field Do this

Condition Select the condition related to the unit (required).

Action Select the action related to condition of the unit
(required).

Effective Dt Enter the date from when the new condition is
effective. The default value is the GL post date
(required).

Reason Select the reason for the condition change
(required).
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Table 6-8 (Cont.) Condition section

|
In this field Do this

Comments Enter any comments associated with the
condition (optional).

In the Condition section, click Apply to apply the new condition on the unit.

Oracle Financial Services Lending and Leasing displays the updated condition in the
Condition section of the Unit Details page (Details link).

6.2.9 Assets sub tab

In the Units screen’s Asset Details section, select the record you want to work with.

If Search Criteria is used to limit the display of unit records. then:

1.

2.

Click ADD to enter a new record.
Click Edit to change an existing record.

In the Asset Details section, enter, view, or edit the following information:

Table 6-9 Asset Details section

In this field Do this

Type Select the unit type (required).

Asset Desc View the description of the asset, formed by
compiling the year, make and model (display
only).

Year Enter the year of the manufacture for the asset
(required).

Make Enter the make of the asset (required).

Model Enter the model of the asset (required).

Sub Model Enter the sub model of the asset (optional).

Identification # Enter the vehicle identification number of the

asset (required).

Invoice Enter the invoice value of asset, that is, the price
at which asset is sold to the producer (optional).

If you are entering or editing a unit, click Activate in the Entry section.

6.2.10 Comments sub tab

The Units Comments page enables you to record comments about the asset and maintain a
history of the past comments in reverse chronological order.

ORACLE

To view the Units Comments page

1.

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Units > Comments.

In the Producers section, select the producer with the units you want to work with.

In the Credit Lines section, select the active credit line with the units you want to work
with.

In the Units section, select the unit you want to work with.
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5. In the Comments section, select the record you want to view.

# Note:

If you choose, use Search Criteria to limit the display of comment records.

6. In the Details section, view the following information:

Table 6-10 Details section

|
In this field Do this

Type Select the comment type. This field notes the
nature of the comment and can help in
classifying comments (required).

Sub Type Select the comment sub type. This field also
notes the nature of the comment and can help
further classify comments (required).

Comments Enter the comment details (required).

Comment By* View the user id of who posted the comment
(display only).

Comment Dt* View the date and time that the comment was

posted (display only).

7. Click Save on the Units Comments page.

*Oracle Financial Services Lending and Leasing notes the user who entered this comment
and the time it was saved.

6.2.11 Tracking Attributes Sub tab

When using the WFP Maintenance screen, you can add tracking attribute information to a unit
at any time using the Tracking Attributes page.

To add or view a tracking attributes attached to a unit

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Units > Tracking Attributes.

For more details on Tracking Attributes refer section Tracking Attributes sub tab in
Producers chapter.

6.2.12 Audits sub tab

The Audit page enables you to search for the unit.
To Search for the attached to a unit

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Units > Audits.

For more details on Audits refer section Audit sub tab in Producers chapter.
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WFP Payments Batch

This section consists of the following topics:

¢ Introduction

e Payments Batch

7.1 Introduction

The WFP Payments Batch window enables you to apply payments received from the producer
at producer, credit line, and unit levels. It also allows for bulk batch payments by displaying the
data received from the producer through a file. After that, you can adjust the unit level
payments.

7.2 Payments Batch

The Payments Batch under WFP enables you to manually apply various types of payments
received from a producer at the producer, credit line, and unit level. You can also specify the
method of applying spreads at each level.

In addition, the Payments Batch enables you to reverse posted payments and void a payment
due to non sufficient funds in the producer’s bank account.

Three types of payments can be made by the producer: statement payment, payoff payment
and regular payment.

To apply payments

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Payments Batch.

The Payment section enables you to select the producer to which payment applies, as well as
method of payment. In this section, Oracle Financial Services Lending and Leasing displays all
the payments that are not yet posted (that is, all payments with status as OPEN.)

1. Inthe Payment section, select the record you want to work with.
2. Inthe Payment section, you can do the following:

e Choose View All to view all the payments applied to date. You can view all the
payments by using scroll bar adjacent to Payments section.

* Use Search Criteria to limit the display of payment records.
* To create a new record, click Add.
* To change an existing record, click Edit.

3. Inthe Payment section, enter, view, or edit the following information:
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Table 7-1 Payment section
|

In this field Do this

Producer Select the producer number and name
(required).

Pmt Mode Select the payment mode (required).

Statement Dt Enter the statement date (optional).

Statement Amt View the total amount due as per statement
(display only).

Pmt Dt Enter the date the payment amount is applied to
the unit. Payment date cannot be less than
either:

The last billing date less value defined in the
system parameter
WFP_MAX_CYCLES_BACKDT

_Or-

The approval date for the producer/start date
credit line/effective date for units.

It also cannot be a future date (required).

Pmt Amt Enter the payment amount received from the
producer. If you do not enter a value in this field,
Oracle Financial Services Lending and Leasing
completes it with the statement amount for the
statement payment when you choose Create
Details in the Action section (required).

Status View the status of the payment batch (display
only).

Post Dt View the batch payment posting date (display
only).

Current Due View the total dollar amount due from the
producer (display only).

Doc # Enter the document/reference number (optional).

Receipt # Enter the receipt number of the payment
(optional).

Reason Select the payment reason (required).

Remarks Enter any comments related to payment. If the

status of the payment is ERROR, Oracle
Financial Services Lending and Leasing displays
the reason why in this field (optional).

4. Inthe Producer Fee Payment section, enter, view, or edit the following information:

Table 7-2 Producer Fee Payment section

|
In this field Do this

Current Due View the current due amount for producer level
fees (display only).

Statement Amt View the due amount as per the statement for
producer level fees.

Oracle Financial Services Lending and Leasing
populates this field only for statement payments
when you choose Create Details in the Action
section (display only).
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Table 7-2 (Cont.) Producer Fee Payment section

|
In this field Do this

Payment Amt Enter the amount to be applied to the producer
level fees. This will default to the statement
amount for the statement payment when you
choose Create Details in the Action section
(required).

Spread Select the payment application spread
(required).

In the Unit Payments section, select the record you want to work with.
In the Unit Payments section, you can do the following:

» Use Search Criteria to limit the display of unit payment records.

* To create a new record, click Add.

* To change an existing record, click Edit.

In the Unit Payments section, enter, view, or edit the following information:

Table 7-3 Unit Payments section

|
In this field Do this

Credit Line Select the credit line from the drop-down list. The
list displays all the credit lines which are linked to
the selected producer for selection.

Unit# Select the unit number to which the payment can
be applied. Based on the credit line selected,
corresponding unit numbers are listed for
selection.

Status View the status of the unit. The payment cannot
be applied against a unit with a status of PAID,
VOID, or PENDING unit (display only).

Current Due View the current amount due on the unit (display
only).
Statement Amt View the total amount due on the unit for the

statement selected in statement date.

Oracle Financial Services Lending and Leasing
will populate this field only for statement
payments (display only).

Payment Amt Enter the payment amount to be applied to the
unit.

This defaults to the statement amount if payment
mode is the statement payment and you choose
Create Details in Action section (required).

Spread Enter the payment spread (required).

The Credit Lines section displays the credit line information for producer selected in
Payment section.

In the Credit Lines section, select the record you want to work with. You can use Search
Criteria to limit the display of credit line records and view the following display only
information:
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Table 7-4 Credit Lines section

|
In this field View this

Credit Line View the credit line details for the producer
selected in Payment section.

Current Due View the current dollar amount due on the credit
line.The credit line current due equals the sum of
unit level current due plus current credit line fee
due.

Statement Amt Displays the dollar amount due for the statement
as of a particular date.

This field is required for statement payments and
is populated when you choose Create Details in
the Action section.

Payment Amt Payment amount made against the credit line.
Data is displayed in case of a posted payment.

Would be blank for a new payment being posted.

The Credit Line Fee Payment section enables you to apply a payment at producer level for
producer selected in the Payments section.

9. Inthe Credit Line Fee Payment section, select the record you want to work with.
10. In the Credit Line Fee Payment section, you can do the following:

e Use Search Criteria to limit the display of total credit fee payment records.

» To create a new record, click Add.

e To change an existing record, click Edit.

11. In the Credit Line Fee Payment section, enter, view, or edit the following information:

Table 7-5 Credit Line Fee Payment section

|
In this field Do this

Current Due View the current due amount for credit line level
fees (display only).

Statement Amt View the due amount as per the statement for
credit line level fees. Oracle Financial Services
Lending and Leasing populates this field only for
statement payments when you choose Create
Details in the Action section (display only).

Payment Amt Enter the amount to be applied to the credit line
level fees. This will default to the statement
amount for the statement payment when you
choose Create Details in Action section
(required).

Spread Select the payment application spread
(required).

The Producer Fee Payment section records the producer level fee amount being paid.
12. In the Producer Fee Payment section, select the record you want to work with.
13. In the Producer Fee Payment section, you can do the following:

e Use Search Criteria to limit the display of total producer fee payment records.
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» To create a new record, click Add.

* To change an existing record, click Edit.

Applying a Statement Payment

A statement payment is the payment made against the monthly statement sent to producer.

To apply a statement payment

1.

g & W DN

10.

On the Oracle Financial Services Lending and Leasing home page, click the WFP master
tab.

Click the Batch Transactions bar link.
In the Batch Transactions link bar, click Payments.
In the Payments section, click Add.

In the Producer field on the Payments section, select the producer from whom the
payment was received.

Oracle Financial Services Lending and Leasing completes the Current Due field with
information about the selected producer.

In the Pmt Mode field, select STATEMENT PAYMENT.

In the Statement Dt field, select the statement date against which the payment is being
applied.

Oracle Financial Services Lending and Leasing completes the Pmt Amt and Statement
Amt fields. The statement amount is the amount expected from the producer for that
statement period. Payment amount, by default, would be the same as statement amount (if
not already entered by the user).

Edit the Pmt Amt field if necessary.

In the Action section, click Create Details.
Oracle Financial Services Lending and Leasing completes the following fields in the Credit
Lines, Credit Line Fee Payment, Producer Fee Payment, and Unit Payments section.

In the Action section, click Post Payment.
Oracle Financial Services Lending and Leasing posts the payment. The payment can be
viewed on the Transaction section of maintenance screens.

Applying a Payoff Payment

The payoff payment is the payment made by producer that pays off the entire outstanding
amount against a unit. Typically, in such cases, the producer would ask for a payoff quote from
the financial institution. The payoff quote for a unit can be generated with WFP Maintenance
window on the Units link’'s Units Maintenance page with New Payoff Quote section.

To apply a payoff payment

1.

g & w DN

On the Oracle Financial Services Lending and Leasing home page, click the WFP master
tab.

Click the Batch Transactions bar link.
In the Batch Transactions link bar, click Payments.
In the Payments section, click Add.

In the Producer field on the Payments section, select the producer from whom payment
was received.

Oracle Financial Services Lending and Leasing completes the Current Due field with
information about the selected producer.

In the Pmt Mode field, select PAY-OFF PAYMENT.
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Oracle Financial Services Lending and Leasing completes the Current Due field with pay-
off amount.

In the Unit Payments section, select the unit to be paid off in unit payments section.

Enter the amount in Current Due field of Unit Payments section in Pmt Amt field in the
Payments section.

In the Action section, click Post Payment.

# Note:

While posting the payment, ensure that sum of all the payments applied at unit
level matches with payment amount in the payment data section.

Applying a Regular Payment

Regular payment is a one-off payment made by the producer. This payment is not against any
statement, nor does it payoff any units. This payment can be spread over multiple units or over
the producer or credit line fee payment.

To apply a statement payment

1.

a » 8 Db

On the Oracle Financial Services Lending and Leasing home page, click the WFP master
tab.

Click the Batch Transactions bar link.
In the Batch Transactions link bar, click Payments.
In the Payments section, click Add.

In the Producer field on Payments section, select producer from whom the payment was
received.

Oracle Financial Services Lending and Leasing completes the Current Due field with
information about the selected producer.

In the Pmt Mode field, select REGULAR PAYMENT.

In the Unit Payments section, select the unit to which payment applies and complete
Payment Amt field,
_Or_

« Inthe Producer Fee Payment section, select the producer to which payment applies
and complete Payment Amt field,

_Or_

* Inthe Credit Line Fee Payment section, select the credit line to which payment
applies and complete Payment Amt field.

In the Action section, click Post Payment.
Oracle Financial Services Lending and Leasing posts the payment and changes the status
to PAYMENT POSTED.

To reverse a payment

1.

On the Oracle Financial Services Lending and Leasing home page, click the WFP master
tab.

Click the Batch Transactions bar link.
In the Batch Transactions link bar, click Payments.

Above the Payments section, select View All.
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5. In the Payment section, select the payment with the status of PAYMENT POSTED that
you want to reverse.

6. Inthe Action section, click Reverse Payment.

To reverse a payment and apply a non sufficient funds (NSF) fee

1. On the Oracle Financial Services Lending and Leasing home page, click the WFP master
tab.

Click the Batch Transactions bar link.
In the Batch Transactions link bar, click Payments.

Above the Payments section, select View All.

a » 0 Db

In the Payment section, select the payment with the status of PAYMENT POSTED that
you want to reverse and apply a non sufficient funds fee as applicable.

6. Inthe Action section, click NSF Payment.
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WFP Units Batch

This section consists of the following topic:

¢ Units Batch

8.1 Units Batch

ORACLE

Producers may send a file to a financial institution that contains the details of units that are
funded by the financial institution. Each file constitutes a batch of unit details and each batch is
identified uniquely. The information sent in the file is in a standard format. Oracle Financial
Services Lending and Leasing parses this file, stores the unit details, and displays this
information on the Unit batch page.

Once the batch is posted, unit information is available on the Unit screen of Wholesale Floor
Planning Maintenance form.

With the Units page on the Batch Transaction window, you can:
* View the posted and unposted batches

e Post the OPEN batch payments

e Void the OPEN batch payments

e Adjust a single unit in a batch

*  View a history of the adjustments to a unit.
To view, post or void batches on the Units batch page

On the Oracle Financial Services Lending and Leasing home screen, click WFP > WFP >
Units Batch.

1. Choose View All above the Unit Batch section to view all the batches, including those not
yet posted.

2. Inthe Unit Batch section, select the record you want to work with and click Show in
Details column.
You can also use the Search Criteria to limit the display of payment records.

The Unit Batch data section displays details of individual units that constitute the batch.
The number of unit records displayed here is same as the number displayed in Total Units
field in Units Batch section.

3. In the Unit Batch section, view the following display only information:

Table 8-1 Unit Batch section
|

In this field View this

Group # The unique number for the batch (group of unit
payments).

Status The status of the unit batch.For an unposted

batch, the status is OPEN.
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Units Batch

In this field View this

Draft Dt The date when the batch payments were
uploaded into Oracle Financial Services Lending
and Leasing.

Total Units The number of unit payment records present in

the batch.

Total Invoice Amt

The total invoice amount of all units in the batch.
This is the total amount paid through the batch.

Effective Dt

The effective date when the payment would be
applied.

Posted Dt

The date of batch posting. This is the date when
the payment is actually posted.

Posted Units

The number of units posted from the batch.

Total Advance Amt

The total amount to be paid as advanced for the
batch.

The Unit Batch section displays the attributes of a single batch payment.

In the Units section, select the record you want to work with and click Show in Details

column.

You can also use the Search Criteria to limit the display of payment records.

In the Unit Batch section, view the following display only information:

Table 8-2 Unit Batch section

In this field Do this
Unit # View the unique system assigned unit number
Status View the status of the unit. This is PENDING

when data is loaded from file to the Unit Batch
page.

Accrual Start Dt

View the date from which interest starts
accruing.

Advance Amt

View the advance amount of the unit loan. This is
the amount given to the producer as a loan and
is same as invoice.

Curtailment Start Dt

View the curtailment start date; that is, when
repayment of principal starts for the unit.

Contract Dt

View the date when the loan contract was
signed. The effective date at unit level would be
the same as contract date.

First Pmt Dt View the date of first payment

Term View the number of months within which the loan
will be repaid by producer.

Maturity Dt View the date of loan maturity for the loan.

Curtailment %

View the percent of the principal to be paid back
each month.

Unit Type

Select the unit type (required).

Credit Line

View or select the credit line data extracted from
the batch file (required).
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Table 8-2 (Cont.) Unit Batch section

|
In this field Do this

Instrument Type View or select the instrument extracted from the
batch file (required).

You can Post and Cancel batches which are in OPEN status.
* To post a batch, click Post Batch in the Action section.

« To cancel a batch, click Void Batch in the Action section.

To adjust a single unit in a batch

1.

10.
11.

12.

13.

On the Oracle Financial Services Lending and Leasing home page, click the WFP master
tab.

Click the Batch Transactions bar link.
In the Batch Transactions link bar, click Units.

Oracle Financial Services Lending and Leasing displays all batches that are not yet
posted.

Choose View All above the Unit Batch section to view all the batches, including those not
yet posted.

The Unit Batch section displays the attributes of a single batch payment.
In the Unit Batch section, select the unit you want to adjust.

The Batch Adjustment section enables you adjust attributes of unit listed in the Unit Batch
section.

In the Batch Adjustment section, enter the following information:

Table 8-3 Batch Adjustment section
|

In this field Do this

Type Select the adjustment type (required).

Value Enter the new value to be applied for a unit
payment (required).

Reason Select the reason for the adjustment.

Comment Enter comments regarding the adjustment
(optional).

Click Save.

Oracle Financial Services Lending and Leasing updates the entry in Batch Units section
and adds an entry in Adjustment History section.

The Adjustment History section displays all the adjustments applied to all units in unit
batch data section.

In the Adjustment History section, view the following display only information.

Table 8-4 Adjustment History section
|

In this field View this
Description The description of change.
Previous Value The value before the adjustment was applied.
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Table 8-4 (Cont.) Adjustment History section

In this field View this

Value The new value applied through the adjustment.

Changed By The name of the person who applies the
changes.

Changed Dt The date on which the value was changed.

Reason The reason for adjustment.

Comment The comment about the value change.
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Oracle Financial Services Lending and
Leasing Reports

The Reports master tab in Oracle Financial Services Lending and Leasing allow you to select a
report in the Reports section, then values you want to use to generate the report in Report
Parameters section and generate a report using that information.

Figure 9-1 Reports - WFP Reports

ORACLE
Financial Services Lending and Leasing

DashBoard Reports x [ e
> Origination
> Servicing Reports — =
e View v Format~ (G0 Frezze fiDetach | odl wrap 30}
é [+

Description Module
'WFP AUDIT VERIFICATION REPORT

'WFP REPORTS

'WFP CREDIT LINES AND QUTSTANDING WFP REPORTS

Credit Lines 'WFP INVENTORY FINANCE STATEMENT WFP REPORTS
Units. 'WFP INVENTORY FINANCING STATEMENT SUMMARY WFP REPORTS
Payments Batch WFP OPEN PORTFOLIO DUPLICATE ID REPORT WFP REPORTS
Units Batch 'WFP OUTSTANDINGS SUMMARY BY BRANCH WFP REPORTS
Reports 'WFP UNIT BALANCE/PAY-OFF REPORT WFP REPORTS

Report Parameters

Vieww Formatw [ Freeze ffiDetach | ofl wrap W0 €5 run Report
Description Value
COMPANY / BRANCH | ALL/ALL ~
PRODUCER NO ALL
UNIT 1D AL
! creorrume ALL
REPORT FORMAT FOF |

> Tools
> Setup

This section consists of the following topics:

e Amortized Txns Log By GL Post Dt (Lease)

e Amortized Txns Log By GL Post Dt (Line)

e Amortized Txns Log By GL Post Dt (Loan)

e GL Posting Log

e Monetary Txns Log By GL Post Dt (Lease)

e Monetary Txns Log By GL Post Dt (Line)

*  Monetary Txns Log By GL Post Dt (Loan)

e Payment Allocations Log By GL Post Dt (Lease)
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Amortized Txns Log By GL Post Dt (Lease)

Payment Allocations Log By GL Post Dt (Line)
Payment Allocations Log By GL Post Dt (Loan)
Pool Txns Log By GL Post Dt

Producer Monetary Txns Log By GL Post DT
WFP Reports

WFP Audit Verification Report

WFP Credit Lines and Outstanding Summary
WEFP Inventory Finance Statement

WEFP Inventory Financing Statement Summary
WFP Open Portfolio Duplicate ID Report

WFP Outstanding Summary by Branch

WFP Unit Balances / Pay-off Quote Report

9.1 Amortized Txns Log By GL Post Dt (Lease)

This servicing report lists monetary transactions by GL post date for leases.

Parameters:

No. of Copies
Company/Branch
From mm/dd/yyyy
To mm/dd/yyyy

Account Number

Figure 9-2 Report - Amortized Lease

og By GL Post Di(Lease) ORACLE
Financial Services Lending and Leasing

Grand Total 000

9.2 Amortized Txns Log By GL Post Dt (Line)

This report lists monetary transactions by GL post date for lines of credit.

Parameters:

ORACLE

No. of Copies
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Amortized Txns Log By GL Post Dt (Loan)

e Company/Branch
e From mm/dd/yyyy
e To mm/dd/lyyyy

e Account Number

Figure 9-3 Amortized Report - Line

ORACLE" ) )
Report: Amortized Txns Log By GL Post Dt(Line) Financial Services Lending and Leasing
Date: 9/7/2012 16:42 PM

GL P

From To

Grand Total :

9.3 Amortized Txns Log By GL Post Dt (Loan

This servicing report lists monetary transactions by GL post date for loans.

Parameters:

* No. of Copies

e Company/Branch
e From mm/dd/yyyy
e To mm/dd/lyyyy

e Account Number

Figure 9-4 Amortized Report - Loan

Report © Amortized Txns Log By GL Post Dt{Lease) ORACLE
Financial Services Lending and Leasing
Date: 2/23/2016 23:28 PM
From Date : 01/31/2016 To Date: 0224/2016

Company: UST1
Branch: USHO
GLPost Date: 02/16/2015

Transaction Deseription Account Customer Txn Amt
COMPENSATION AMORTIZE COMPENSATION 2015120001250 HONEYSINGH Y00 13024
COMPENSATION 2015030014283 RODRIGUEZ ROBINSON 31033

Transaction Total 44057

COMPENSATION COMPENSATION 2015120001250 HONEYSINGH YOYO 379.86
RENTAM ORTIZE COMPENSATION 2015090014283 RODRIGUEZ ROBINSON 615.85
Transaction Total 93571

DEPRECIATION AMORTIZE DEPRECIATION 2015100001137 K MAVIN 985 52
Transaction Total 98552

DEPRECIATION DEPRECIATION 2015120001250 HONEYSINGH Y0YO 13024
COMPAMORTIZE DEPRECIATION 2015030014283 RODRIGUEZ ROBINSON 31033
Transaction Total 44057

DEPRECIATION DEPRECIATION 2016010014015 KUMAR NARESH 14725
RENTAM ORTIZE DEPRECIATION 2015120001250 HONEYSINGH Y0YO 379.86
DEPRECIATION 2016010013175 KALLAM NANI 14725

DEPRECIATION 2015100001137 | HAVIN 51.74

DEPRECIATION 2015120001284 DEREK DEREK 15643

DEPRECIATION 2015120012787 K MAVIN 643

DEPRECIATION 2015120012838 EATHAN EATHAN 267.92

DEPRECIATION 2015060001323 SMITHJOHN 4611

DEPRECIATION 2015090014283 RODRIGUEZ ROBINSON B15.85

DEPRECIATION 2015120001317 CHODA PHANINDRA / TEST TEST 14544

DEPRECIATION 2015120012913 M AJITHA 13483
Transaction Total 2,156.98

RENT AMORTIZE RENT 2015090014283 RODRIGUEZ ROBINSON 61585
RENT 2016000014016 KUMAR NARESH 14725

RENT 2015120012913 M AJITHA 134.83

RENT 2016010013175 WALLAM NANI 14725

RENT 2015120001284 DEREK DEREK 15643

RENT 2015120012836 EATHAN EATHAN 267.92

RENT 2015120012767 K NAYIN 643

RENT 2015120001317 CHODA PHANINDRA / TEST TEST 14544

RENT 2015120001250 HONEYSINGH YOO 379,86

RENT 2015060001323 SMITH JOHN 4611

RENT 2015100001137 K NAYIN 51.74
Transaction Total 2,156.98

RENT COMPAMORTIZE RENT 2015120001250 HONEYSINGH YOO 13024
RENT 2015030014283 RODRIGUEZ ROBINSON 31033

1of2

ORACLE
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9.4 GL Posting Log

This servicing report lists general ledger postings is available for loans, lines of credit, and
leases.

Parameters:

* No. of Copies

e Company/Branch
e From mm/dd/yyyy
e To mm/dd/lyyyy

Figure 9-5 GL Posting Log - Report

Report : GL Posting Log ORACLE’
Date: 10/29/2019 3:04 AM Financial Services Lending and Leasing
From Date: 01 1 To:
NLO2
ALL AMOUNT ARE IN NZD
Date Description Dr Amount Cr Amount
1 2 3 4 5 6 7 8 9 10

10/22 | PAYMENT - 110000 | cB-001 0.00
/2019 | ADVANCE
10/22 | PAYMENT - 110000 | cB-002 11222 323232 0.00
/2019 | ADVANCE
10/22 | PAYMENT - 200000 | CB-001 0.00
/2019 ADVANCE
10/22 | PAYMENT - 200000 | cB-002 11222 323232 0.00
/2019 ADVANCE
10/22 | BAYMENT - 110000 | cB-002 11222 323232 105.85 0.00
/2019 | ADVANCE

BILLED
10/22 | PAYMENT — 200000 | CB-002 11222 323232 0.00 105.85
/2019 | ADVANCE

BILLED
11/30 | PAYMENT - 110000 | cB-001 0.00
/2019 | ADVANCE
T1/30 | PAYMENT - 200000 | CB-001 5,349.12
/2019 | ADVANCE
11/30 | PAYMENT - 110000 | cB-001 11222 323232 0.00
/2019 | ADVANCE

BILLED
11/30 | PAYMENT - 110000 | cB-001 0
/2019 | ADVANCE

BILLED
11/30 | BAYMENT - 200000 | CB-001 11222 323232 0.00 112.68
/2019 ADVANCE

BILLED
11/30 | PAYMENT - 200000 | CB-001 0.00 105.80
/2019 | ADVANCE

BILLED

Company Total: 5,889.60 5,899.60
US01

1of2

9.5 Monetary Txns Log By GL Post Dt (Lease)

This servicing report lists monetary transactions by GL post date for leases.

Parameters:

* No. of Copies

e Company/Branch
e From mm/dd/yyyy
e To mm/ddlyyyy

Pool

ORACLE 0.4
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Monetary Txns Log By GL Post Dt (Line)

Figure 9-6 MonetaryTXN GLPost Report - Lease

Report : Monetary Txns Log By GL Post Dt (Lease)

Date: 2/9/2016 0:29 AM

GL Post Date From: 01/01/1800 Te: 01/01/2048

Company: NLO2
Branch: NLR1

GL Post Date: 02/18/2012
ALL AMOUNT ARE IN

Transaction
ACTIVE

BILL/IDUE DATE

DEPRECIATION

FIRST PAYMENT

FND CASH
SALES/ADVANCE
AMOUNT

FND PREPAID FEES

LATE CHARGE

Product

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE

LEASE-VE
LEASE-VE
LEASE-VE
LEASE-VE

-

]

Action
POST

POST

POST

POST

POST

POST

POST

Account#
20120200011643

20120200010752
20120200010752
20120200010752
20120200010752
20120200010752
20120200010752
20120200010752
20120200011643
20120200010752

20120200010752
20120200011643
20120200011643

20120200011643

20120200011643

20120200010752

20120200010752
20120200010231
20120200010231
20120200010231

ORACLE

Customer
KARLSSON ANDRES /
AUDREY

KARLSSON ANDRES /|
AUDREY

KARLSSON ANDRES /|
AUDREY
KARLSSON ANDRES /|

AUDREY
KARLSSON ANDRES /
AUDREY
KARLSSON ANDRES /
AUDREY
KARLSSON ANDRES /
AUDREY
KARLSSON ANDRES /
AUDREY
KARLSSON ANDRES /
AUDREY

KARLSSON ANDRES /
AUDREY
KARLSSON ANDRES /
AUDREY

KARLSSON ANDRES /
AUDREY

KARLSSON ANDRES /
AUDREY

KARLSSON ANDRES /
AUDREY

KARLSSON ANDRES /
AUDREY

KARLSSON ANDRES /
AUDREY

KARLSSON ANDRES /
YUTAKA OZAKA | AKANE
YUTAKA OTAKA | AKANE
YUTAKA OZAKA | AKANE

9.6 Monetary Txns Log By GL Post Dt (Line

This servicing report lists monetary transactions by GL post date for lines of credit.

ORACLE"

Parameters:

* No. of Copies

e Company/Branch

e From mm/dd/lyyyy

e To mm/dd/lyyyy

*  Pool

Financial Services Lending and Leasing

Batch#

NONE

NONE

NONE

NONE

NONE

NONE

NONE

NONE

NONE

NONE

NONE

NONE

NONE

NONE

NONE

NONE

NONE
NONE
NONE
MNONE

Last Updated By
UNDEFINED

Transaction Total
UNDEFINED

UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED

Transaction Total:
INTERNAL

Transaction Total:
INTERMAL

Transaction Total
INTERNAL

Transaction Total:
INTERMAL

Transaction Total
INTERNAL

INTERNAL
UNDEFINED
UNDEFINED
UNDEFINED

Transaction Total:

Date Total:
Branch Total:
Company Total:
Grand Total:

Txn Amt
1]
0.00
263890
263.89
263.80
263890
262.89
263.80
26380
26380
263.80
263.80

2.638.90
8500

8,500.00
263.80

263 80
12500

12,500.00
826.11

626 11
13.18

13.18
a
a

o
-783.410.08
2,881.38
451384 71

1.656,300.84
1.834,785.82

9-5



Figure 9-7 Monetary TXN GL Post Report - Line

Report : Monetary Txns Log By GL Post Dt (Line)
Date: 3/9/2016 10:47 AM
GL Post Date From: 01/01/1800 To: 01/01/2048

Company: US01

Branch: USHQ

GL Post Date: 02/19/2016
ALL AMOUNT ARE IN

Transaction
ACTIVE

BILL/DUE DATE

INTEREST ACCRUAL

INTEREST BILLED

LINE RECEIVABLES

GL Post Date: 02/23/2016
ALL AMOUNT ARE IN

Transaction
ACTIVE

uso

uso

Product
LOC-HE

LOC-HE

LOC-HE

LOC-HE

LOC-HE

LOC-HE

LOC-HE

LOC-HE

Product
Loc

Loc

<m

ZZZZZZZZZZZZZT

Action
POST

POST

POST

POST
POST

BILL

BILL

POST

Account#
20160100010056

20160100010056

20160100010056

20160100010056
20160100010056

20160100010056

20160100010056

20160100010056

Account#
20160200010245
20150700010275
20150600010268
20150800010282
20151000010202
20160200010097
20160200010154
20160200010146
20160200010138
20160200010112
20160200010104
20150900010299
20160200010352

Chapter 9

Monetary Txns Log By GL Post Dt (Loan)

ORACLE

Customer
BROAD STUART / SMITH
EDWIN

BROAD STUART / SMITH
EDWIN

BROAD STUART / SMITH
EDWIN

BROAD STUART / SMITH

BROAD STUART / SMITH
EDWIN

BROAD STUART / SMITH
/

BROAD STUART / SMITH
EDWIN

BROAD STUART / SMITH
EDWIN

Customer
KALLAM NAVEEN
UNIT2 LINE
UNIT1 LINE
UNIT3 LINE
UNITS LINE
TEST SEPALINE
TEST1 SEPALINE1
TEST1 SEPALINE1
TEST1 SEPALINE1
TEST SEPALINE
TEST SEPA LINE
UNIT4 LINE
TEST COMPENSATION

9.7 Monetary Txns Log By GL Post Dt (Loan)

ORACLE

This servicing report lists monetary transactions by GL post date for loans.

To generate the Payment Allocations Log by GL Post Dt - Loan report

Financial Services Lending and Leasing

Batch#
NONE

NONE

NONE

NONE
NONE

NONE

NONE

NONE

Last Updated By
UNDEFINED

Transaction Total:

UNDEFINED

UNDEFINED

Transaction Total:

UNDEFINED
UNDEFINED

Transaction Total:

UNDEFINED

UNDEFINED

Transaction Total
UNDEFINED

Transaction Total:

Date Total:

Last Updated By
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED
UNDEFINED

Txn Amt
o
0.00
1323
69.63

20183
1323

69.63

20193
6963

1323

20193
15000

15,000.00

15,605.79

Txn Amt

coocococoooooooo

1. On the Oracle Financial Services Lending and Leasing home page, click the Reports
master tab.

2. On the Reports page, click the GL Transaction drop-down link.

3. Click Monetary Txns Log By GL Post Dt - Loan.

4. Complete the following parameters:

* No. of Copies

e Company/Branch
*  From mm/ddlyyyy
*  To mm/ddlyyyy

* Pool
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Figure 9-8 Monetary TXN GL Post Report - Loan

Report : Monetary Txns Log By GL Post Dt (Loan) ORACLE’
Date: 2/9/2016 0:11 AM Financial Services Lending and Leasing
‘GL Post Date From: 01/01/1800 To: 01/01/2048

Company: NLOZ
Branch: NLHQ
GL Post Date: 01/11/2012

ALL AMOUNT ARE IN usD
Transaction Product B Action Accounts Customer Batchs Last Updated By Txn Amt
ACTIVE LOAN-UN ¥ POST 20120100010315  ANDERSON NEO!ANNA NONE UNDEFINED 0
Transaction Total: 0.00
FND CASH LOAN-UN ¥ POST 20120100010315  ANDERSON NEO!ANNA NONE INTERNAL 5000
SALES/ADVANCE
AMOUNT
Transacton Total: 5.000.00
LOAN RECEIVABLES LOAN-UN v POST 20120100010315  ANDERSON NEO/ANNA NONE UNDEFINED 5000
Transacton Totak: 5.000.00
DateTotab  10,000.00
GL Past Date: 01/15/2012
ALL AMOUNT ARE IN usD
Transaction Product B Action Accounts Customer Batchs Last Updated By Txn Amt
ACTIVE LDAN-UN ¥ POST 20120100010888  THORPE GRAHAM /LISA NONE UNDEFINED 0
Transaetion Totak: 0.00
FND GASH LDAN-UN ¥ POST 20120100010828  THORPE GRAHAM /LISA NONE INTERNAL 5000
SALES/ADVANCE
AMOUNT
Transaction Total: 5,000.00
LOAN RECEIVABLES LOAN-UN ¥ POST 20120100010888  THORPE GRAHAM /LISA NONE UNDEFINED 5000
Transaction Total 5,000.00
Date Totab  10.000.00
GL Post Date: 011172012
ALL AMOUNT ARE IN uso
Transaction Product B Action Account# ustomer Batchs Last Updated By Txn Amt
ACTIVE LOAN-UN v POST 20120100011412  ANDERSON NEO/ ANNA NONE UNDEFINED 0
LOAN-UN ¥ POST 20120100011420  THORPE GRAHAM /LISA NONE UNDEFINED 0
Transaction Total: 0.00
FND CASH LOAN-UN ¥ POST 20120100011420  THORPE GRAHAM /LISA NONE INTERNAL 5000
SALES/ADVANCE LOAN-UN ¥ POST 20120100011412 ANDERSON NEO / ANNA NONE INTERNAL 5000
AMOUNT
Transaction Total: 10,000.00
LOAN RECEIVABLES LOAN-UN v POST 20120100011412  ANDERSON NEO/ ANNA NONE UNDEFINED 5000
LOAN-UN ¥ POST 20120100011420  THORPE GRAHAM /LISA NONE UNDEFINED 5000
Transsction Total  10,000.00
CHGOFF ADVANCE / LOAN-UN i CHGOFF  20120200010001  SPARROW JACK /MARYY NONE INTERNAL 5000
FRINCIPAL LOAN-UN v CHGOFF 2020200010108 DALE ALAN / JESSICA NONE INTERNAL 5000
ADJUSTMENT TO LOAN-VE N ADJUST_PL 2015120001375 ANAND AJITHA UNDEFINED INTERNAL 1000
ADVANCE / PRINCIFAL - us :
ADD Transaction Total: 0.00
Date Towl: 23079133

Branch Total:  1.315.574.81
Company Total: ~ 26,671,088.28
Grand Total:  30.440.105.79

9.8 Payment Allocations Log By GL Post Dt (Lease

This servicing report lists payment allocations sorted by GL post date for leases.

Parameters:

* No. of Copies

e Company/Branch
*  From mm/ddlyyyy
*  To mm/ddlyyyy

*  Account Number

ORACLE" 9-7
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Figure 9-9 Payment Allocation GL Post Report - Lease

Report : Payment Allocations Log By GL Post Date {Lease] ORACLE
Date: 2/8/2016 23:29 PM Financial Services Lending and Leasing

GL Post Date From: 01/01/1300 To- 01/01/2043

aL Post

ALL AMOUNT ARE

Baten § TXn Date Txn Amount Het Amount Erinciple Interest overage
T-2012-170- GE/1E I049.63 304963 ] ] ]
o019
0E/1E/20 1353.58 1353.58 o o 1353.58 o
Batch Total: 2,403, 21 000 0,00
Date Totai: 4, T, 80321 000 000
HE
GL Post Da /16/2012
ALL AMOUNT RRE IN USD
Batch § Account # Tit: Txn Amount Net Amount Erinciple Intereat Other overage
HONE 20120200011643 AR 26389 263,60 o o 263,85 o
ANDRE:
AUDREY
26389 26185 0.00 000
FIFIT] FFNE] 000 Te3. 6% 0,00
GL Post Date:. 03/16/2012
ALL MMOUNT ARE IN USD
Datch § Account # Title Txn Amount Het Amount Principle Interest Other overage
RORE F012030001179 TOEKT 7 IIT.11 L3I0 T T IIL.IT T
FIT11 IAL.I0 T.00 T.00 LT 0,00
31111 311,11 000 0.00 31131 0.00
GL Post Date: 1170172012
ALL AMOUNT ARE IN USD
Batch Account § Taxn Amount Net Amount Principle Interest Other overage
HORE 2012020001075 ZE1.69 ZE1.65 ] : 763.80 ]
3111 ] ] ]
260.37 ] ] ]
Batch Total:  855.37 855.37 0.00 .00 E55.37 0.00
Date Total. B55 .37 855,37 000 0.00 855,37 0.00
COMpany Total: &,833.58 5,833.68 0.00 0.00 5,833 .50 0.00
Company: USOL
.00 0.00 a 0.00
20151200011317  CHODR 1000 o o o
FHANIND
TEST TES!
Eatcn Totals T,000.00 T.00 0,00
Date 1,000_00 0_00 000
Company 36 572 84 000 000
Grand 42, 406.42 000 0.00

9.9 Payment Allocations Log By GL Post Dt (Line

This servicing report lists payment allocations sorted by GL post date for lines of credit.

Parameters:

* No. of Copies

e Company/Branch
e From mm/dd/lyyyy
e To mm/dd/lyyyy

e Account Number

ORACLE 0.8
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Payment Allocations Log By GL Post Dt (Loan)

Figure 9-10 Payment Allocation GL Post Report - Line

By GL Post Date (Lir

ORACLE
i ial Services Lending and Leasing

From: 01/01/1800 To: 01/01/2048
: UsOl
12/12/2015
ALL AMOUNT ARE IN USD
Batch # Account # Title Txn Date Txn Amount Net Emount Principle Interest Other Overage
PAY-2015-167- 201501000111 ROBERT 11/11/2015 2300 2300 2111.03 188.97 o o
00002002 70 BOREN
201501000111 ROCBERT 11/11/2015 2300 -2300 -2111.03 -1B8.97 a 1]
70 BOREN
Batch Total: 4 600.00 0.00 0.00 0.00 7.00 0.00
PAY-2015-173- 201501000111 ROBERT 10/15/2015 6000 ~5000 -36870.3 2008.65 120 ]
00002001 70 BOREN
201501000111 ROBERT 10/15/2015 €000 &000 3870.35 2009.65 120 o
70 EOREN
Batch Total: 12,6000.00 0.00 0.00 0.00 0.00 0.00
201501000111 ROBERT 12/01/2015 TEO0 -7600 -5227 .84 -2237.16 -135 [}]
70 BCREN
201501000111 ROBERT 12/01/2015 7600 7600 5227.64 2237.16 135 [
70 BOREN
Batch tal: 15,200.00 0.00 0.00 0.00 a.00 0.00
PAY-2015-346- 201501000111 ROBERT 12/12/2015 10001 10001 T338.75 2472.25 190 o
00002004 70 EOREN
Batch Total: 10,001.00 10,001.00 7,338.75 2,472.25 190.00 0.00
Date Total: 41,801.00 10,001.00 733895 3.472.25 190.00 .00
GL Post Date: 12/14/2015
ALL BMOUNT ARE IN USD
Batch # Account # Title Txn Date Txn Amount Net Amount Principle Interest Other Overage
PAY-2015-346- 201501000111 ROBERT 271272005 10001 ~10001 733675 T2472.25 150 ]
00002004 70 BOREN
Batch # Account # Title Txn Date Txn Amount Net Amount Principle Interest Other Overage
Batch Total: 10,001.00 -10,001.00 -7,338.75 -2,472.25 -1%0.00 0.00
Date Total: 10,001.00 -10,001.00 -7,338.75 -2,4732.325 -150.00 0.00
Ccmpany Total:  51,802.00 0.00 000 .00 0.00 .00
Grand Total: 51,802.00 0.00 0.00 0.00 0.00 0.00

9.10 Payment Allocations Log By GL Post Dt (Loan

ORACLE

This servicing report lists payment allocations sorted by GL post date for loans.
Parameters:

* No. of Copies

e Company/Branch

e From mm/dd/yyyy

e To mm/dd/lyyyy

e Account Number

9-9
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Figure 9-11 Payment Allocation GL Post Report - Loan

g By GL Post Date (Loan) ORACLE’
Financial Services Lending and Leasing
GL Post Date From: 01/01/2000 To: 01/01/2022
Company
Mod, ACH DAYMENTS
GL Post Date: 12/22/2015
ALL AMOUNT ARE IN EUR
Batch # Account # Title Txn Date Txn Amount Net Amcunt Principle Interest Other Overage
DAY-2012-170- 20120200010 06/18/2012 31028B.48 9822.12 OSB3 .21 178.81 o0 []
00005019 laz
20120200010 FISHER 06/18/2012 1e728.72 4182.18 3823.61 57 144 o
736
20120200011 06/18/2012 17279.16 4344.79 4075.98 178.81 90 o
601
20120200011 06/18/2012 7385.56 1846.39 1577.82 214.57 54 o
618
20120400010 06/18/2012 16241.04 4060.26 378l.8 143.46 135 ]
691
20120400011 06/18/2012 4560.84 1140.21 974 .25 143 46 s []
857
20120500010 D6/18/2012 13905.6 3476.4 3282.81 Bl.09 112.5 [}
501
20120500011 06/18/2012 1G6EB.EE 55E.22 475.12 g1.00 [ []
963
Batch Total: 117,15B8.06 29,428.57 27,544.71 1,235.86 64B.00 0.00
Date Total: 117,158.06 29, 438.57 27,544.71 1,235.86 648.00 0.00
GL Post Date: 12/23/2015
ALL AMOUNT RRE IN EUR
Batch # Account # Title Txn Date Txn Amount Net Amcunt Principle Interest Other Overage
PAY-2015-350- 20151200010 MADHU 12/15/2015 -300 -150 -94 5E -55.44 0 []
00004001 012 BOBBURT
Batch Total: -300.00 -150.00 -04 BE& -55._44 0.00 0.00
Date Total: -300.00 -150.00 -G4 . 5E -55 .44 0.00 0.00
Company Total: 2,281,240.2 B63,695.22 B843,587.76 15,560.18 Z,488.62 Z,058.65
Grand Total: 2,402,451.5 895 620.51 871 132.47 18,514.25 3,915.14 2,058.65

9.11 Pool Txns Log By GL

This servicing report lists monetary transactions by GL post date for loans.

ORACLE

Parameters:

* No. of Copies

e Company/Branch
e From mm/dd/yyyy
e To mm/dd/lyyyy

*  Account Number

* Pool

Post Dt
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Figure 9-12 Pool TXN GL Post Report

ORACLE’
Report: Pool Txns Log By GL Post Date Financial Services Lending and Leasing
Date: 10/9/2013 16:02 PM
Date From 01/01/1800 To 01/01/2048
Us01
USHQ
ALL AMOUNT ARE IN USD
12/29/2007
TEST_01
Account Pool Status Transaction Amount Contract Amount
20130400011137-TEST LEAD OPEN OPEN 5,000.00 5,000.00
20130400011137-TEST LEAD OPEN OPEN 5,000.00 5,000.00
Pool Total: 10,000.00 10,000.00
Post Dt Total: 10,000.00 10,000.00
Branch Total: 10,000.00 10,000.00
Company Total: 10,000.00 10,000.00

9.12 Producer Monetary Txns Log By GL Post DT

This servicing report lists producer monetary transactions sorted by GL post date for loans.
Parameters:

e No. of Copies

e Producer

e Company/Branch

e From mm/dd/yyyy

e To mm/ddlyyyy

ORACLE 011
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WFP Reports

Figure 9-13 Producer Monetary TXN GL Post Report - Lease

ORACLE’
Financial Services Lending and Leasing

Report : Producer Monetary Txns log By GL POST Dt
Date: 2/8/2016 5:16 AM

GL Post Date From: 01/01/1800 To: 01/01/2048
Cempany: NLO2

Branch: NLR1

GL Post Date: 01/21/2012

Producer: 1A-00004 KIMBERLY CHRYSLER PLYMOUTH
ALL AMOUNT ARE IN EUR

Txn Description Account Customer Name Txn Amt
DISBURSEMENT PRODUCER 48807
PAYMEMNT
Transaction Total: 486.07
Producer Total: 488.07
Producer: IL-00003 SAM LEMAN CHRYSLER PLYMOUTH MAZDA
ALL AMOUNT ARE IN EUR
Txn Description Account Customer Name Txn Amt
DISBURSEMENT PRODUCER 216
PAYMENT
Transaction Total: 216.00
Producer Total: 216.00
Date Total: T04.07
GL Post Date: 02/16/2012
Producer: IL-00003 SAM LEMAN CHRYSLER PLYMOUTH MAZDA
ALL AMOUNT ARE IN USD
Txn Description Account Customer Name Txn Amt
COMPENSATION UPFRONT 20120200011619 FISHER DUNCAN { PRICE 24
Transaction Total: 956.00
COMPENSATION UPFRONT 20120200011601 SMITH EDWIN / KIM 500
Transaction Total: 956.00
COMPENSATION UPFRONT 20120200011619 FISHER DUNCAN { PRICE 216
MONTHEND
Transaction Total: 956.00
DISBURSEMENT COMPENSATION 201202000116189 FISHER DUNCAN / PRICE 218
MONTHLY
Transaction Total: 956.00
Producer Total: 956.00
Date Total: 956.00
GL Post Date: 02/29/2012
Txn Description Account Customer Name Txn Amt
WRITE OFF DUE TO CHGOFF 20120300010701 STANDFORD MICHEAL / HANNAH 488238
Transaction Total: 889.58
WRITE OFF DUE TO CHGOFF 20120300011733 STANDFORD MICHEAL / HANNAH 4113
Transaction Total: B899.58
Producer Total: 899.58
Date Total- 1,335.31
Branch Total: 10,926.93
Company Total: 3491284
Grand Total- 41,307 .86

9.13 WFP Reports

The Wholesale Floor Plan command enables you to create the following reports:

*  WFP Audit Verification Report

*  WFP Credit Lines and Outstanding

«  WFP Inventory Finance Statement

*  WFP Inventory Financing Statement Summary
*  WEFP Open Portfolio Duplicate ID Report

*  WEFP Outstanding Summary by Branch

*  WEFP Unit Balance/Pay-off Report

9.14 WFP Audit Verification Report

ORACLE

The WFP Audit Verification report lists the active units under each credit line for a producer.
This report can be printed and the hard copy can be used for an actual floor audit to verify that
units are available on producer’s floor.

To generate the WFP Audit Verification Report
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WFP Credit Lines and Outstanding Summary

On the Oracle Financial Services Lending and Leasing home page, click the Reports

master tab.

In the Reports section, choose WFP AUDIT VERIFICATION REPORT.

In the Report Parameters section, complete the following parameters:

BATCH PRINTER
COMPANY/BRANCH
PRODUCER NO
UNIT ID

Credit line

Figure 9-14 WFP Audit Verification Report

Report : Wholesale Audit Verification Report ORACLE
Date: 2/5/2016 6:45 AM Financial Services Lending and Leasing

PARK SOUTH HOTEL LLC
584 EROADWAY RM 302
LOIZA, PR

PUERTO RICO 00772

Contract Maturity Unit No ID# Make Model Principal Car Digital M50 Explanation
Date Date Balance Seen? Odometer

Credit Line NEW : NEW
1z/12/2015 03/12/2017 0000001002 32498732947 PORCHE PR &5 0.00

12/14/2015 11/13/2016 0000001006 233234 PORCEE AR 500 0.00

Total : 0.00

9.15 WFP Credit Lines and Outstanding Summary

The WFP Credit Lines and Outstanding Summary report lists the credit lines for each producer
and outstanding balance.

ORACLE

To generate the WFP Credit Lines and Outstanding Summary report

1. On the Oracle Financial Services Lending and Leasing home page, click the Reports
master tab.

2. Inthe Reports section, choose WFP CREDIT LINES AND OUTSTANDING SUMMARY.

3. Inthe Report Parameters section, complete the following parameters:

BATCH PRINTER
COMPANY/BRANCH
PRODUCER NO
CREDIT LINE NO

9-13



Figure 9-15 WFP Credit Lines Outstanding Report

Report : Wholesale Floor Plan Credit Lines and Outstanding
Date: 2/8/2016 1:17 AM

Producer Name Producer No Line Name Line Amcunt

Chapter 9
WEFP Inventory Finance Statement

ORACLE’

Financial Services Lending and Leasing

Outstanding Available $Utilized Units/Line

DRITEM_WFE 4002 PJ1 - BJl 50,000.00

20,000.00 30,000.00 40.000 10

Bub Total : 50,000.00

20,000.00 30,000.00 40.000 10

Total : 50,000.00

9.16 WFP Inventory Finance Statement

The WFP Inventory Finance Statement report displays in detail the unit level principal, interest
and service fees ( totals of which are mentioned in Statement Summary report).

ORACLE

20,000.00 30,000.00 40.000 10

To generate the WFP Inventory Finance Statement report

1.

On the Oracle Financial Services Lending and Leasing home page, click the Reports

master tab.

In the Reports section, choose WFP INVENTORY FINANCE STATEMENT.

In the Report Parameters section, complete the following parameters:

«  BATCH PRINTER

e COMPANY/BRANCH
*  PRODUCER NO

« STATEMENT DATE
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Figure 9-16 WFP Inventory Finance Statement Report

Report : Wholesale Floor Planning Inventory Financing Statement ORACLE'
Date: 2/8/2016 1:26 AM Financial Services Lending and Leasing

9.17 WFP Inventory Financing Statement Summary

The WFP Inventory Financing Statement Summary report displays current and past due
principal, interest, and unit services fees, along with the other fees applicable at credit line and
producer level. The report is as current as of a statement date and does not display the latest
dues.

To generate the WFP Inventory Financing Statement Summary report

1. On the Oracle Financial Services Lending and Leasing home page, click the Reports
master tab.

2. Inthe Reports section, choose WFP INVENTORY FINANCING STATEMENT SUMMARY.
3. Complete the following parameters:

e BATCH PRINTER

e COMPANY/BRANCH

*  PRODUCER NO

e STATEMENT DATE

ORACLE 015
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Figure 9-17 WFP Inventory Finance Statement Summary Report

Report : Wholesale Inventory Financing Statement Summary ORACLE’
Date: 2/8/2016 1:21 AM Financial Services Lending and Leasing

9.18 WFP Open Portfolio Duplicate ID Report

ORACLE

The WFP Open Portfolio Duplicate ID report identifies and lists multiple occurrences of the
vehicle identification number within retail and wholesale accounts. A identification number
appears in the report only if multiple occurrences exist. The vehicle identification number is the
only criteria used for checking duplicates, irrespective of the model and make.

To generate the WFP Open Portfolio Duplicate ID report

1. On the Oracle Financial Services Lending and Leasing home page, click the Reports
master tab.

2. Inthe Reports section, choose WFP OPEN PORTFOLIO DUPLICATE ID REPORT.
3. Inthe Report Parameters section, complete the following parameters:
«  BATCH PRINTER
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Figure 9-18 WFP Open Portfolio Duplicate Report

Report : Wholesale Open Portfolio Duplicate Id report ORACLE
Date: 2/8/2016 1:31 AM Financial Services Lending and Leasing
VIN Producer Name Credit Line Unit Ne Principal Balance
123123 GA-00007 - PRITAM WFP BJl : PJ1 4001 15,000.00
234224 GA-00007 - DRITAM WFP DJl : PJl 5001 0.00
1203 GA-00007 - PRITAM WFD DJl : PJl 5002 0.00
32498732947 PR-00005 - PARK SOUTH NEW : NEW 1002 0.00
HOTEL LLC
234234 GA-00007 - DRITAM WFP DJl : DPJ1 5003 2,000.00
585646156546 GA-00007 - DRITAM WFD DJl : PJl 6001 3,000.00
234234 PR-00005 - PARK SO0UTH NEW : NEW 1006 0.00
HOTEL LLC
5865546454 GA-00007 - PRITAM WFP BJ1 : PJ1 6002 0.00
Total - 20,000.00

9.19 WFP Outstanding Summary by Branch

The WFP Outstanding Summary by Branch report provides summary of the outstanding
amount due from producers.

To generate the WFP Outstanding Summary by Branch report

1. On the Oracle Financial Services Lending and Leasing home page, click the Reports
master tab.

2. Inthe Reports section, choose WFP OUTSTANDING SUMMARY BY BRANCH.
3. Inthe Report Parameters section, complete the following parameters:

e COMPANY/BRANCH

¢  PRODUCER NO

e  BATCH PRINTER

ORACLE 9-17
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Figure 9-19 WFP Outstanding Summary Report

Report : Wholesale Floor Planning Outstandings Summary By Branch ORACLE’

Date: 2/8/2016 1:39 AM Financial Services Lending and Leasing

Branch Name Producer Name Producer No Sum of Principal Balance
Total : 0 0.00

9.20 WFP Unit Balances / Pay-off Quote Report

The WFP Unit Balances/Pay-off Quote Report lists units under each credit line and displays
interest owed as well as current principal balance for the unit. The report also displays the
payoff quote as of when report was created. Oracle Financial Services Lending and Leasing
summarizes the data for each credit line to display the credit line level total. In turn, Oracle
Financial Services Lending and Leasing also summarizes all the credit line level data to arrive
at the producer level balance.

To generate the WFP Unit Balances | Pay-off Quote Report

ORACLE

1.

On the Oracle Financial Services Lending and Leasing home page, click the Reports
master tab.

In the Reports section, choose WFP UNIT BALANCES / PAY-OFF QUOTE.
In the Report Parameters section, complete the following parameters:

e COMPANY/BRANCH

* PRODUCER NO

e BATCH PRINTER
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Figure 9-20 WFP Unit Balance PayOff Report

Report : Wholesale Floor Plan Unit Balance/Pay-off Report ORACLE" .
Date: 2/8/2016 1:54 AM Financial Services Lending and Leasing
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Appendix : Rounding Amounts and Rate
Attributes

Rounding Amounts

Generally in the lending industry, computed amounts (interest, fees, costs and so on) are
rounded to the second decimal place. However, there are occasions where the rounding of the
computed amounts has to be carried out using different methods. Oracle Financial Services
Lending and Leasing supports the rounding, raising of or cutting off calculated amount.

* Rounding will increase the resulting amount to next number up to the second decimal,
based on values of third decimal.

* Raising will always increase the resulting amount to next number up to the second
decimal.

e Cutting off will always cut the number after the second decimal.

# Note:

The system rounds only calculated amounts (calculated fees, calculated payment,
and so on) and not user-entered amounts.

You can choose the rounding method you want to use by setting the parameter value for
system parameter CMN_AMOUNT_ROUND_METHOD on the Administration form (Setup
menu > Administration master tab > System drop-down link > System Parameters link >
System tab).

You can choose the rounding factor you want to use by setting the parameter value for system
parameter CMN_AMOUNT_ROUND_FACTOR on the Administration form. Currently, Oracle
Financial Services Lending and Leasing supports rounding up to two decimals only.

Examples of how resulting amounts differ by RAISE, ROUND, and CUTOFF:

Table A-1 Example 1: Amount: 234.136
]

Method Result
Round 234.14
Raise 234.14
Cut off 234.13

Table A-2 Example 2: Amount: 234.134
]

Method Result
Round 234.13
Raise 234.14
Cut off 234.13

ORACLE Al
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Table A-3 Example 3: Amount: 234.1319999

Method Result
Round 234.13
Raise 234.14
Cut off 234.13

Rate Attributes

The system supports rounding of index rate to keep the rate calculation as simple as possible
for the customers. The general practice is to round the rate to nearest eighth (1/8th) (to keep
index rate in the multiple of 125) or fourth (1/4th) (to keep index rate in the multiple of 25). The
system rounds only index rate and not the margin or final rate. You can define the index
rounding method on the Product tab’s Product Definition screen for variable rate product.

The system currently supports the following rounding of methods.
1. NO ROUNDING TO INDEX RATE

2. INDEX RATE ROUNDED TO NEAREST.25

3. INDEX RATE ROUNDED TO NEAREST.125

NO ROUNDING TO INDEX RATE:

Select this method for no rounding.

INDEX RATE ROUNDED TO NEAREST 0.25:

Select this method to round up to 1/4th (to keep the index rate in the multiple of 0.25).

Examples:

Table A-4 Example 1

Type Value
Current rate: 5.125
Round of rate: 5.25

Table A-5 Example 2

Type Value
Current rate: 5.124
Round of rate: 5.00

INDEX RATE ROUNDED TO NEAREST 0.125:
Select this method to round up to 1/8th (to keep the index rate in the multiple of 0.125).

Examples:

Table A-6 Example 1

|
Type Value

Current rate: 5.325
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Table A-6 (Cont.) Example 1

_________________________________________________________________________________|
Type Value

Rate rounded to: 5.375

Table A-7 Example 2
]

Type Value
Current rate: 5.312
Rate rounded to: 5.250
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Appendix : Payment Amount Conversions

ORACLE

The following table contains the calculations Oracle Financial Services Lending and Leasing
uses to convert different payment frequencies (weekly, biweekly, semi monthly, and so on) to
standard monthly values for installment accounts.

Table B-1 Term Payments

Payment Frequency

Scheduled Monthly Income Amount

D = Deferred

Zero fill

P = Single payment

Zero fill

W = Weekly (due every week)

Multiple by 4.33

B = Biweekly (due every two weeks)

Multiple by 2.16

E = Semi-monthly (due twice a month) Multiple by 2
M = Monthly (due every month) As given

L = Bimonthly (due every two months) Divide by 2
Q = Quarterly (due every three months) Divide by 3
T = Triannually (due every four months) Divide by 4
S = Semi-annually (due twice a year) Divide by 6
Y = Annually (due every year) Divide by 12
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